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I N T R O D U C T I O N
What do you want from 
Quicken? 2

Where can I learn more? 3

What can 
Quicken do 
for me?
If you’re new to Quicken, this 

book will help you get started, 

hassle-free. But even after you 

know the basics, you’ll find tools 

here that will help you take the 

steps you need to reach your 

long-term financial goals.
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What do you want from Quicken?

Typically we make financial decisions in response to a major 
life event: graduation from college, the birth of a child, or the pur-
chase of a first home. 

Can I afford to send my kids to college? 

Can I afford that house? 

How can I get out of debt? 

Can I retire when I want to?

This book helps you make the best use of 
Quicken’s many features to answer ques-
tions such as these, make informed 
financial decisions, and reach your goals.
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Where can I learn more?
S H OW  M E  V I D E O  C L I P S  Trying out a feature 
you’ve never used before? The Show Me video clips can walk 
you through the basics. From the Help menu, choose ShowMe 
Videos to see a list of topics. (CD-ROM required.)

S T E P - BY - S T E P  P RO C E D U RE S Use Quicken Help 
for quick instructions on a specific task. From the Help menu, 
choose Index and then type the name of the subject area you need 
help with. The bottom part of the window displays all the Help 
topics related to that task. Click to highlight the one you want, 
and then click Display.

H OW  D O  I  You can click “How do I?” in most Quicken 
windows to see a list of tasks you can perform from the current 
window. Press the F1 key on your computer keyboard for
related information. 

O N S C RE E N  M A N UA L  The Onscreen Manual 
describes how the features work together and provides ideas for 
using them in special situations. It also has links directly to the 
step-by-step instructions in Help. From the Help menu choose 
Onscreen Manual.

FRE Q U E N T LY  A S K E D  Q U E S T I O N S The 
Quicken Product Support team may already have addressed 
your question. From the Help menu choose Product Support and 
then click Go to Web. (You must have Internet access.)

To make your 
Quicken Help 
easier to read
In any Quicken Help win-
dow, click Options. Choose 
Font to increase or decrease 
the size of the typeface in 
your Help window.
Introduction  3
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G E T  S T A R T E D  
What do I do first? 6

How can I get the 
most out of Quicken? 7

How can I get 
answers from Quicken? 8

How can Quicken 
do the work for me? 10

What’s the 
quickest 
way to get 
started?
We’ve designed Quicken to pay real 

dividends right away. These few 

pages will help you learn about great 

time-saving features and enjoy the 

benefits of Quicken from the very first 

day. 
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What do I do first?

The first time you use Quicken, it automatically walks you 
through New User Setup. 

1 Follow the EasyStep® instructions to create your first 
checking account. Don’t worry if you don’t have your latest 
bank statement. You can edit this information later. 

2 Click Next to move through the windows. 

3 In the Summary window, review your information, make 
changes if necessary, and then click Done. Congratulations! 
You have just created your first Quicken account. 

Entering transactions in your new account

Your new Quicken checking account has a register similar to that 
in a conventional paper checkbook. From now on, when you 
write checks, record the transactions in your Quicken checking 
account register.

After you create your first account, Quicken opens the register 
and places the cursor in an empty transaction at the end of 
the register.

To enter a transaction in your Quicken register:

1 Enter information about the new transaction into each field.

To open an 
account
To open an account, from 
the Finance menu, choose 
Account List. In the Account 
List, select the account you 
want, and then click Open.
6



■ Enter the name of person or institution to whom the pay-
ment or deposit is made.

■ Be sure to enter the amount for payment or deposit in the 
correct column.

■ Enter categories for income and expenses.

2 Click Enter to save the transaction.

Creating accounts
You can create accounts and enter transactions for almost any 
account you have in the real world: checking, savings, invest-
ments, auto loans, and mortgages. 

How can I get the most out of Quicken?

Using categories

To get the most out of Quicken’s reporting and planning tools, 
you should assign categories to transactions as you enter them. 
Categories are labels that track how much you’re spending on 
particular items, such as rent, groceries, or dining. 

For example, you probably buy your clothes at several different 
stores, with as many different payees as there are stores. If you 
assign the “Clothing” category to these transactions, it’s easy to 
do a cash flow report that shows how much you’ve spent on your 
clothes, no matter where you bought them. 

To create a new 
account
From the Finance menu, 
choose Account List, and 
then click New. Choose an 
account type and click Next. 
Follow the EasyStep instruc-
tions to set up the account.

For more information, from 
the Help menu choose 
Onscreen Manual. Click Set-
ting up accounts and catego-
ries, and then click What are 
accounts?

The account Overview page displays information about your account, 
such as interest rates and whether yoy have enabled online access. 

Can I use one 
data file for all 
my accounts?
Most people only need one 
data file to track all their 
household accounts. From 
the Help menu, choose 
Onscreen Manual. Click Set-
ting up accounts and catego-
ries, and then click What are 
accounts?
Get Started  7



When one category isn’t enough

Sometimes a single transaction includes items that belong to mul-
tiple categories. There’s an easy way to handle this in Quicken.

1 Enter the payee and net amount for the transaction and then 
click Split. 

2 In the Split Transaction window, enter the category and 
amount for each item and group of items.

How can I get answers from Quicken?

Creating reports and graphs

Using the categories you assign to your transactions, the Reports 
and Graphs Center can show you where your money goes. 

How can I learn 
more about 
registers?
From the Help menu, 
choose Onscreen Manual. 
Click Organizing your 
finances, and then click 
About the register.

Click the Split button to split one transaction into multiple categories.

This transaction shows three categories assigned to one transaction. 
The [Petty cash] line is a transfer to another account.
8



1 From the Reports menu, choose Reports and Graphs Center. 

2 On the left, choose the topic area you want to investigate. 

3 On the right, select the report or graph you want, and then 
click Create Now. Click Customize if you want to change the 
level of detail in some area of the report.

What about the really tough financial questions?

The Planning Center combines your own Quicken data with a 
question-and-answer survey of your financial situation, which 
lets you answer challenging financial questions even before 
you’ve entered a lot of transactions into your register. From the 
Planning menu, choose Planning Center, and then select a ques-
tion such as: 

■ Can I afford to buy that house?

■ Can I afford to send my kids to college?

■ Can I afford to retire when I want to?

TI P Even if you have plenty of room on your hard drive, you 
should back up your Quicken data on a separate disk (for exam-
ple, a 3.5-inch, Zip® or Jaz® disk). For step-by-step instructions, 
from the Help menu, choose Index, and enter files, backing up or 
files, restoring.

How can I speed 
up my data entry?
From the Help menu, 
choose Index, and enter 
Quick Keys.
Get Started  9



How can Quicken do the work for me?
After you create a few accounts and begin to enter transactions, 
you have done everything necessary to start enjoying the benefits 
of Quicken. You could stop right here. But don’t! The rest of this 
chapter contains tips that can simplify your record-keeping and 
drastically reduce your data entry. 

Quicken remembers what you enter

Let’s say you entered a payment to your local newspaper, The 
Tribune. Next month, as you enter just the first few letters of “The 
Tribune” in the register, the QuickFill feature recalls your previ-
ous “Tribune” transaction and automatically enters the rest of the 
information for you. You can change any of this information, 
then record the transaction. These are called memorized transac-
tions.

Quicken adds to the Memorized Transaction list whenever you 
enter a transaction with a new payee. As the list grows, you may 
want to clean out the entries you rarely use. 

Schedule your transactions
Chances are, your bills don’t all arrive on the same day. They 
trickle in, and you try to pay each one in a timely fashion. To save 
time and effort, you can have Quicken schedule these transac-
tions. When you schedule a transaction, you enter the details of 
the bill and tell Quicken:

■ When to make the next payment 

■ How often to make future payments

Manage your 
Memorized 
Transaction list
From the Banking menu, 
choose Memorized Transac-
tion List. To delete a memo-
rized transaction, select it on 
the list, and then click 
Delete. 

Deleting a memorized trans-
action from this list doesn’t 
remove it from any of your 
Quicken registers. It just 
won’t appear on the drop-
down list of transactions.

To learn about... Search the Help Index for...
memorized transactions memorized transactions, using

Memorized Transaction list lists, memorized transaction

keeping the amount from 
changing when you use a 
memorized transaction

memorized transactions, locking
10



When the scheduled transaction comes due, you pay the bill the 
usual way, with a handwritten check, a printed check, an online 
payment, or a direct withdrawal. You can schedule a transaction 
even if your payment amount varies from month to month. 

Quicken alerts you to important changes

When you set up an Alert, Quicken lets you know when certain 
conditions or limits are met in one of your accounts. From the 
Finance menu, choose Alerts, and click the appropriate tab. 

■ Minimum or maximum account balances

■ Credit card limits

■ Important tax dates and alerts based on your data

■ Stock price limits

■ Key investment news

Where will I see my Quicken reminders?

Quicken displays your scheduled transactions, alerts, and 
reminders in these places. 

Quicken Reminders window By default, your reminders are 
displayed in the Reminders window when you start Quicken. 
These include scheduled transactions (bills to pay, checks to 
print), calendar notes, and Alerts about important changes. 

Schedule a 
transaction
From the Finance menu, 
choose Financial Calendar. 
In the Financial Calendar’s 
Transaction list, click to 
select the transaction you 
want to schedule for recur-
ring payments, then drag it 
to a date on the calendar. If 
you are entering a new 
transaction, click and drag 
the entry marked “Use this 
for a NEW one!”

Select an account and enter a minimum 
or maximum balance. Quicken will warn 
you whenever you reach this limit.

You can set alerts in multiple 
areas to keep tabs on a variety 
of conditions.
Get Started  11



My Finances Center The Financia Center displays scheduled 
transactions, calendar notes, and Alerts about important changes. 

BillminderTM Billminder displays your Quicken reminders 
when you start Windows, whether or not you open Quicken.

Quicken.com For more information, see “How can I use 
Quicken when I’m away from home?” on page 20.

Enter transactions without launching Quicken
On days when your only task is entering transactions, use Quick-
Entry. This “mini-application” opens quickly and displays only 
your account registers. From your Windows desktop, double-
click the QuickEntry icon. From the Account menu, choose an 
account, and then enter transactions as usual. The next time you 
open Quicken, it prompts you to accept the transactions. 

To set up a 
Calendar note
You can use Calendar notes 
to create any reminder you 
like. From the Finance 
menu, choose Financial Cal-
endar. Click Note and enter 
a memo to yourself.

To learn about... Search the Help Index for...
seeing reminders when you 
start Quicken

reminders, using

seeing reminders when you 
start Windows

Billminder, starting and stopping

Financial Calendar calendar, using

scheduled transactions to 
automate regular payments

scheduled transactions, using

paying your credit card bill credit cards, entering payments

creating a group of scheduled 
transactions

transaction groups, setting up

adding notes to the Financial 
Calendar

calendar, notes

setting thresholds for credit 
limits, stock prices, and 
account balances

alerts, using
12



G O  O N L I N E  
How do I start? 14

Why should I bank online? 15

Can I download 
credit card
transactions, too? 17

Is online investment
tracking available? 18

How can I pull it 
all together? 19

How can I use 
Quicken when I’m
away from home? 20

Why should 
I go online 
with 
Quicken?
As you use Quicken, you will quickly 

learn shortcuts for entering 

transactions in the register. But if you 

really want to save time, online 

banking and investment tracking is 

the only way to go. 
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To go online with Quicken, you must have Internet access. 
With Internet access, you can:

■ Connect to your bank or financial institution and download 
transactions as they clear 

■ Pay your bills without writing checks or licking stamps

■ Download credit card transactions 

■ Download your investment transactions

You can also download stock quotes, news, historical prices, and 
asset classes directly into your Quicken data file. And when you 
are away from home, you can see your portfolio and reminders 
from any Web-connected computer. 

How do I start?
What if I don’t have an ISP? If you do not have an Internet 
Service Provider (ISP), you can sign up with one from your 
Quicken CD-ROM. Close all open applications and insert the CD-
ROM. From the Windows Start menu in the lower left of your 
computer screen, choose Programs, and then select the Quicken 
program group. From the Quicken program group, click the 
installation icon for America Online.

What if I don’t have a Web browser? To set up the online 
banking features, you must have a Web browser with 128-bit 
encryption. If you installed Quicken using the Express installa-
tion, Quicken has already installed the correct browser for you. If 
you did not use the Express installation, you can install the 
browser now. Run the Install program again, but this time click 
No when prompted to uninstall the existing version of Quicken. 
Then click the Custom installation option. In the Select Installa-
tion Components window, select only Internet Explorer.

To set up your 
Quicken Internet 
connection
After you have installed an 
Internet Service Provider 
and successfully connected 
to the Internet, set up 
Quicken to work with your 
new Internet connection. 
From the Edit menu, choose 
Internet Connection Setup. 
14



Why should I bank online?
You use a computer. Your bank uses a computer. Why not con-
nect the two? You’ll save time entering transactions and you can 
be sure you always have up-to-date account information.

Just contact a participating financial institution to apply for 
online service with Quicken, and then enable your Quicken 
account to use it. You can apply at multiple financial institutions 
and use multiple accounts with this service. 

You can use the Quicken online account access feature with 
checking and savings accounts, depending on the services 
offered by your financial institution. Quicken helps protect your 
transaction security with a PIN and state-of-the-art encryption.

Download your account information

With online account access, you can download your recent 
cleared transactions and online balances from your financial 
institution (usually as of the previous business day). 

Quicken gives you a chance to compare your financial institu-
tion’s records with your Quicken register. When you download a 
transaction that has cleared your financial institution, Quicken 
either matches it to one you’ve entered in your Quicken register, 
or marks it as New. This is a great way to catch those ATM with-

To get started 
using online 
banking 
From the Banking menu, 
choose Online Banking 
Setup, and then choose the 
account you want to set up. 
To see if your financial insti-
tution firm offers online ser-
vice with Quicken, from the 
Finance menu, choose 
Online Financial Institutions 
List. You can usually apply 
right away, either over the 
Internet or by phone. Your 
financial institution will 
send you a PIN and specific 
information for you to 
enable your Quicken 
accounts to use the service.

1. Click 
Update/Send 
to download 
your recent 
transactions.

2. View your 
downloaded 
transactions 
here. 

3. After you download, click Compare to Register 
to add the transactions to your register.
Go Online  15



drawals you forget to record. The comparing and matching pro-
cess also simplifies reconciling. When you’re ready to reconcile 
the account, the cleared transactions have already been checked 
off. There’s hardly any work left for you to do. 

Make your payments online

Paying bills online is quicker and easier than writing and mailing 
a check. Just create and send online payment instructions in the 
Quicken Online Center.

Online payment can also simplify many everyday situations.

■ Do you ever misplace bills because they trickle in at different 
times? Just set up online payment instruction on the day you 
receive the bill, specify when the bill should be processed, 
and send the instruction. It’s entered in your Quicken regis-
ter, and you can forget about it.

■ Do you have a car loan? Are you going to be making the 
same payment every month for the next few years? Create a 
repeating online instruction to make it for you at the appro-
priate interval for the duration of the loan.

To pay bills 
online if your 
bank doesn’t offer 
online service 
with Quicken
If your financial institution 
doesn’t offer the online 
financial services through 
Quicken, you can apply to 
use the Intuit Online Pay-
ment service with any U.S. 
banking account with 
check-writing privileges. 

When your application is 
accepted, your financial 
institution will send you a 
PIN and specific informa-
tion for enabling your 
Quicken accounts to use
the service.

Enter your payment information just as when 
writing a check. Then click Update/Send to 
send your payment processing instructions.
16



Can I download credit card
transactions, too?
You can download and compare your credit card transactions, 
just as you would transactions from a bank or other financial 
institution. In most cases, Quicken even adds the merchant 
names and categories for you. Downloading transactions as they 
clear is the easiest way to track your credit card balance. 

To see if your financial institution firm offers online credit card 
service with Quicken, from the Finance menu, choose Online 
Financial Institutions List. Or, for information on the Quicken 
Credit Card, see “Apply for a Quicken Credit Card” on page 86.

To go online with 
financial 
institutions that 
don’t support 
Quicken online 
banking 
You may be able to bank 
online even if your financial 
institution doesn’t support 
online banking with 
Quicken. For information, 
from the Help menu, choose 
Index, and enter 
WebConnect.

To learn about... Search the Help Index for...
fees and services financial institutions, fees and 

services

downloading transactions online account access

online payment online payments

using online payment if your 
bank doesn’t offer it

Intuit Online Payment service

security for your financial 
information

online payments, security

contacting your financial 
institution

financial institutions, contacting

storing PINs PINs

One Step Update updating, one step update

To keep track of 
all those PINs
If you have more than one 
online financial institution, 
it can be difficult to remem-
ber multiple PINs (Personal 
Identification Numbers). 
Quicken makes it easier by 
letting you store all your 
PINs under one password. 
You only need to remember 
one password to have easy 
access to multiple accounts 
and institutions. From the 
File menu, choose PIN 
Vault, and then Setup. 
Go Online  17



Is online investment tracking available?
Many brokerage firms and mutual fund companies offer online 
investment tracking services through Quicken. Apply for online 
service with your brokerage just as you would for a bank or other 
financial institution. Here’s why: 

■ Your information is more current than with periodic broker-
age statements, and you save the work of entering invest-
ment transactions from a detailed statement.

■ Download your latest investment transactions, account bal-
ances, and holdings from your financial institution. Having 
this data directly from your broker really simplifies capital 
gains tracking. 

■ If your financial institution allows checking privileges with 
your investment account, download your checking transac-

To learn about... Search the Help Index 
for...

fees and services financial institutions, fees and 
services

downloading transactions online account access

security for your financial 
information

online payments, security

using your Quicken Credit 
Card with online account access

Quicken Credit Card

contacting your financial 
institution

financial institutions, contacting

storing PINs PINs

To get started 
with online 
investment 
tracking
From the Investing menu, 
choose Online Investing 
Setup, and then choose the 
account you want to set up. 
To see if your broker offers 
this service, from the 
Finance menu, choose 
Online Financial Institutions 
List. You can usually apply 
right away, over the Internet 
or by phone. Your financial 
institution will send you a 
PIN and information to 
enable your Quicken 
accounts for online service.
18



tions at the same time that you download investment 
transactions (if you have set up a linked checking account).

■ You can even trade directly with your financial institution 
using links to its Web site from within the Online Center.

How can I pull it all together?
After you have enabled a few online accounts, you can speed 
things up even further by downloading all your online transac-
tions in one online session. To start One Step Update, just click 
the Online button and select the financial institutions and trans-
actions you want to update.

View your balances and 
holdings by clicking 
these tabs.

Then click Compare to 
Register to update your 
Quicken investment 
register.

View all your 
downloaded 
transactions here. 

To learn about... Search the Help Index for...
fees and services financial institutions, fees and services

online investment tracking 
tasks

online investment tracking

security for your financial 
information

security, online financial services

contacting your financial 
institution

financial institutions, contacting
Go Online  19



How can I use Quicken when I’m away 
from home?
The great thing about the Internet is that it’s a two-way highway. 
If you register a user name and password at Quicken.com, you 
can export some of your Quicken data to the Web. From the 
Finance menu, choose Quicken on the Web, and then choose 
Quicken.com. At Quicken.com, click “Personalize this portfolio 
now or log in here.” 

Portfolio Export Upload your Quicken investment portfolio to 
the Web, where you can track it from any Web-connected com-
puter, anytime, anywhere. For more information, from the Help 
menu, choose Index, and enter portfolio export.

Quicken Reminder Export Upload your Quicken reminders 
to the Web. For more information, from the Help menu, choose 
Index, and enter exporting, reminders to Quicken.com.

WebEntry Don’t lose track of your transactions when you are 
away from home. Just enter them at the Quicken.com Web site 
from any Web-connected computer, and then import them into 
Quicken when you return home. For more information, from the 
Help menu, choose Index, and enter WebEntry.

Select security quotes 
and news.

Select transactions to 
download and account 
information to update.

Select the Quicken 
Web features to update. 

Select Portfolio Export 
here, then click 
Customize to choose 
which securities to 
include.

To enter 
transactions away 
from home
Use WebEntry to enter 
Quicken transactions on any 
computer that is connected 
to the Web. Just use the 
transaction entry form on 
the Quicken.com WebEntry 
page. The next time you 
open Quicken, download 
the transactions (click the 
Online button) and accept 
the new transactions into 
Quicken (from the Banking 
menu, choose Banking 
Activities, and then Accept 
transactions entered on 
the Web). 
20



T R A C K  Y O U R  C A S H  F L O W
Why should I care 
about cash flow? 22

What is my real 
net worth? 24

Am I covering my bases? 27

Where does 
all our 
money go?
Ever feel like your cash flow is more of 

a cash river? The first step to taking 

control of your financial life is getting 

a clear picture of where your money 

really goes, and where you stand 

now. 
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Why should I care about cash flow?

Cash flow is all about learning what your money can do for 
you. By understanding how much comes in and where it goes, 
you can plan realistically without feeling deprived. To get the 
most from the cash flow features, it helps to create Quicken 
accounts to track your most active real-world accounts:

■ Your primary checking account (especially if it has an 
ATM card)

■ Credit cards 

■ Cash

Cash Flow reports reveal spending patterns

A Quicken cash flow report can reveal interesting patterns in 
your daily expenses. Here’s a typical cash flow report.

■ What are your biggest expenses?

■ What are your most frequent expenses?

■ How much of your income goes to housing? Utilities?

If you move your cursor over the totals, the cursor turns 
into a small magnifying glass when details are available. 

Double-click to zoom in on the details.

To create a 
new account
From the Finance menu, 
choose Account List, and 
then click New. Choose an 
account type and click Next. 
Follow the EasyStep instruc-
tions to set up the account.

To create a 
cash flow report
From the Reports menu, 
choose Reports and Graphs 
Center. On the left, choose 
“Easy answer reports and 
graphs.” On the right, select 
“Where did I spend my 
money during the 
period ... ?” Select a time 
period from the drop-down 
menu, then click
Show Report.

When you assign 
categories to your 
transactions, the cash 
flow report shows 
exactly where your 
money goes. See any 
surprises?
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Now suppose you want an even closer look. How much you are 
spending on all your car-related expenses? Use the Quicken item-
ized categories report to investigate all transactions assigned to 
the Auto category. It includes subcategories you have created.

Take a look at Quicken’s other EasyAnswer reports. In a couple 
of mouse clicks, you’ll know what your investments are worth, 
see if your spending has changed, or find out if you are saving 
more or less than you used to. Run one of these reports anytime 
you want a snapshot of how you are doing.

You can customize an EasyAnswer report to include just the 
information that is most important to you. Just create the report 
and then click Customize. In the Customize window you can add 
or delete accounts and categories to be included in the report, or 
change many other report settings. 

Memorize the report and run it again next month

You may find there is a report you create and customize on a reg-
ular basis. You don’t have to repeat your work each time. Just 
click Memorize. Quicken saves your report settings, so you can 
run it again next month to compare how you are doing over time. 
The memorized report is available whenever you need it from 
the Reports menu.

TI P Help ensure the accuracy of checking and credit card 
accounts by reconciling when you get your monthly statements. 
Check the Account Info page to see when you last reconciled.

To create an 
itemized 
categories report
From the Reports menu, 
choose Reports and Graphs 
Center. On the left, choose 
“Easy answer reports and 
graphs,” then on the right 
select “How much did I 
spend on ... ?” Select a cate-
gory and click Show Report.

To memorize a 
report
Create a report and then 
click Memorize. Enter a 
name and date range for the 
report. The next time you 
want to run the report, from 
the Reports menu, choose 
Memorized Reports and 
then select it from your list 
of memorized reports. 

To learn how to 
reconcile an 
account
From the Help menu, 
choose Index, and
enter reconciling.
Track Your Cash Flow  23



Check-up: What does cash flow mean to me?

We’ve all heard about the person who “knows the price of every-
thing and the value of nothing.” Here’s an exercise. How many 
hours did you work to earn the total monthly income on your 
cash flow report? Now look at your expenses. How many hours 
did you work to pay for groceries? For rent? Entertainment? Do 
these expenses reflect the value of your labor? This reality check 
can point out how your spending reflects what matters to you.

What is my real net worth?

Assets minus liabilities

Basically, your net worth is the value of all the items you own 
(your assets) minus the amount you owe (your liabilities). 
Quicken calculates net worth by adding the balance of your 
checking, savings, cash, asset and investment accounts and then 
subtracting the balances of your credit card and liability accounts 
(including loans) from this amount.

The more complete your Quicken data is, the clearer your finan-
cial picture will be. 

H E L P  F O R  H O M E OW N E R S To show the actual 
value of what you own and owe, Quicken sets up a pair of 
accounts, an asset account to track the value (for example your 
home is worth $150,000) and a liability account to track your debt 
(for example, a $100,000 loan). The difference between the two is 
your equity.

To create a 
net worth report
From the Reports menu, 
choose Reports and Graphs 
Center. Choose “Easy 
answer reports & graphs”, 
and then select “What am I 
worth?” Click Show Report.

To exclude an account from 
your net worth report, click 
Customize. Then select the 
Accounts tab and click the 
account name to remove the 
account from the report. 
Click Include to include or 
exclude individual catego-
ries. Click Memorize to save 
the report.

This net worth 
graph shows the 
assets (what you 
own) as positive 
numbers and 
liabilities (how 
much you owe) as 
negative numbers.

This line 
represents your net
worth.
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Counting up your assets

Quicken figures the positive side of your net worth by adding up 
the assets you’ve entered into Quicken. Start by setting up:

■ A separate Quicken account for each real-world account, 
including cash on hand.

For example, set up a savings account to track the money 
you’ve put away in savings, a checking account, and so on.

■ An asset account to track the cost basis of your home. 

For more information about cost basis, see “Document home 
improvements” on page 57.

■ An account to track your 401(k) or other retirement accounts.

The Quicken EasyStep account setup helps you set up and 
track the value and performance of your 401(k).

To track other types of investments, Quicken has two options:

■ To track just the value of your investments, set up an asset 
account. For example, asset accounts are ideal for tracking 
CDs, Treasury bills, and fixed annuities.

■ To track not only the value but also the performance of your 
investment, set up an investment account.

You can set up a Quicken account for almost any type of real-
world investment. For details on tracking investments, see 
“What’s the easiest way to track my investments?” on page 74.

Identifying your liabilities

Use Quicken to track your debts in credit card and liability 
accounts. For a complete picture, set up:

■ One credit card account for each credit card you use.

■ Separate liability accounts to track:

how much you owe on your mortgage

how much you owe on your car, or any other loans 

To set up an asset 
account
From the Finance menu, 
choose Account List, and 
then click New. Choose 
Asset as the account type (or 
Home or Vehicle if appro-
priate) and click Next. Fol-
low the EasyStep 
instructions to set up the 
account.

To set up and 
track your 401(k)
From the Investing menu, 
choose Investing Activities, 
and then Track 401(k).

To download the 
value of your car
If you track the value of 
your car in a car asset 
account, you can download 
its estimated resale value. In 
the asset account’s Over-
view page, enter the car’s 
make, model, and year, then 
click in the Observation for 
downloading car values.
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Check-up: What does net worth mean to me?

The Planning Center in Quicken can help you anticipate how 
your net worth may be affected by future life events:

■ Sending the kids to college

■ Paying off debt earlier

■ Making a major purchase

Click “Can I afford to retire when I want to?” to create a person-
alized retirement plan and set specific goals. Return to this page 
on a regular basis to track your progress and to see how current 
financial decisions affect your long-term goals.

To learn about... Search the Help Index for...
Quicken accounts, which 
types to use, how many 
you need

accounts, about

when to use an investment 
account instead of asset 
account

investment accounts

updating asset and liability 
accounts

assets, updating balance

To view the 
Planning Center
From the Planning menu, 
choose Planning Center.

The Planning Center contains tools that incorporate your own Quicken 
data with advice to help you prepare for a solid financial future.
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Am I covering my bases?

You need a reserve fund

To check your reserves, create a net worth report, but this time 
include only the accounts that contain liquid assets, which can be 
cashed in, (such as a money market fund account, checking and 
savings accounts).

You should have three to six months of living expenses in case of 
an emergency or loss of income. Self-employed people may need 
more, especially if their income is not steady. Compare your liq-
uid assets to the total expenses on your cash flow report. Have 
you set aside enough to see you through a temporary setback?

To estimate how much you need, create a budget for the period 
you want to cover. When you create a budget, you can have 
Quicken fill it in, based on the information you’ve entered in 
your Quicken registers. For more information on budgeting, see 
“Is there a painless way to cut expenses?” on page 34 and “How 
can I save more?” on page 35.

To plan for major 
purchases
In the Planning Center, click 
“Can I afford this pur-
chase?” to help make 
informed decisions about 
future expenses.

To set up an 
emergency 
reserve
To create an Emergency 
Reserve, use the Savings 
Analysis snapshot on the 
My Finances Center. From 
the My Finances Center, 
click Customize, and then 
choose Customize This 
View. In the Customize win-
dow, under Available Items, 
select Savings Analysis, and 
click Add to move it to Cho-
sen Items. Click OK. 

From Savings Analysis, click 
Customize This Report. In 
the Customize Savings win-
dow, click Emergency Fund, 
and then select an account 
for your Emergency Fund. 
Click OK. 
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Insurance coverage

Nobody can predict the future, but if you track the value of your 
assets, you can at least take reasonable precautions to insure 
them. Take a look at your insurance coverage (on your car, your 
home, your life). 

How can you be sure you have adequate coverage? Home-
owner’s or renter’s insurance may cover you for fire or theft, but 
if you have valuable antiques, collectibles, computer equipment, 
or art, you may need a rider in addition to your regular policy. 
Research private disability insurance if your employer does not 
provide it. This is critical for replacing your income if you 
become disabled. Likewise, long-term care insurance is an invest-
ment that you may never need, but if you do need it, it will be 
invaluable. If you have dependents, life insurance can provide 
for them in the event that you are no longer there.

Start by visiting the Quicken InsureMarket, a comprehensive 
online personal insurance service. You can get quotes, learn the 
basics, and evaluate risk using the tools and information pro-
vided. You can also learn ways to save on your insurance costs.

If you’ve entered all your furnishings, home equipment, and 
other valuables in Quicken Home Inventory, create an insurance 
coverage summary report to see a summary listing of all your 
belongings and their values, and then compare the value of your 
belongings with your insurance coverage. For more information 
about insurance or Quicken Home Inventory, see “How can I 
safeguard my investment?” on page 50.

TI P  F O R  RE N T E R S Too many people make the mis-
take of believing insurance is only for homeowners. Renters need 
insurance, too! Look at the total value of everything in your 
Quicken Home Inventory. Unless you could realistically replace 
these items from the money in your emergency reserve, then you 
need insurance.

To visit 
InsureMarket
From the Household menu, 
choose Insurance Research 
Online. You must have 
Internet access to use this 
feature.

To open Home 
Inventory
From the Household menu, 
choose Quicken Home 
Inventory.
28



S A V E  M O R E
How can I manage 
my debt? 30

Is there a painless 
way to cut expenses? 34

How can I save more? 35

How can I 
keep more of 
my money?
Now that you know where your 

money is going, you can use that 

information to make choices that 

could pay off down the road—or 

right away. 
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It’s easy to run up credit card bills, even when you’re careful. 
At every stage of life, the demands on your resources seem to 
grow. The credit card companies only make it worse by bombard-
ing you with offers of easy credit, especially if you’ve just pur-
chased a home. 

How can I manage my debt?

Managing debt: A few smart moves

It’s easier to avoid trouble than to dig your way out after you’ve 
racked up too many debts.

■ Stick to one or two credit cards and pay them off each month. 
Use a debit card to enjoy the convenience of a credit card 
without incurring debt.

■ Pay your bills promptly and in full.

■ Try to make a 20% down payment when you buy a home.

■ Monitor your credit rating with the major credit reporting 
agencies. If your record contains errors, insist on corrections. 

Track your credit card spending

Set up a Quicken account to track your credit card purchases, and 
keep the transactions up to date. Quicken credit card accounts are 
similar to Quicken bank accounts. If you’ve set up a bank 
account, you already know most of what you need to use a credit 
card account.

When you create a credit card account to monitor your credit 
card spending, you will quickly see these benefits:

■ Your reports will be more complete and accurate (when you 
include credit card debt in cash flow reports, they provide a 
more complete financial picture).

■ You can use categories to track the types of things you typi-
cally buy on credit.

To create a credit 
card account
From the Finance menu, 
choose Account List, and 
then click New. Choose 
Credit Card as the account 
type and click Next. Follow 
the EasyStep instructions to 
set up the account.
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■ You can track all the balances you owe at any given time, as 
well as how much you are paying in interest charges and 
annual fees.

■ You can set up an Alert in Quicken to let your know when 
you’re reaching your credit card account limit.

Quicken can track your credit card for you

This is the smartest, easiest way to track your credit card. If your 
bank offers online banking, see if you can apply for a credit card 
that will let you download transactions into Quicken. If not, 
apply for the Quicken Visa card. For information, see “Apply for 
a Quicken Credit Card” on page 86. It requires almost zero data 
entry, and you always know exactly where you stand. Just down-
load and categorize transactions as they clear.

Is there such a thing as “good debt”?

Some kinds of debt are better than others. Home loans and stu-
dent loans may contribute to your future financial security. But if 
you have other outstanding debt, consider this:

Convert consumer debt to a home equity loan. In many 
cases the interest on a home equity loan is tax deductible, and the 
interest is almost always lower than a credit card’s interest rate. 

A loan from your 401(k). Yes, it’s your retirement you’re 
borrowing from, but at least you are paying the interest to your-
self. Just pay it back before you leave your employer. In most 
cases, outstanding loans are due upon termination
of employment. 

To set up a credit 
card Alert 
From the Finance menu, 
choose Alerts. Click the 
Accounts tab and then select 
Credit Card Limits as the 
alert area.

To apply for a 
Quicken Credit 
Card
The Quicken Credit Card is 
a Visa Platinum Card, 
offered through Intuit and 
Travelers Bank, with time-
saving online account access 
available. To apply, see 
“Apply for a Quicken Credit 
Card” on page 86. 

To learn about... Search the Help Index for...
entering credit card payments credit cards, entering payments

reconciling your credit card 
account and paying the bill

credit cards, balancing

tracking credit accounts credit cards, about tracking in 
Quicken
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Reduce your debt

The Quicken Debt Reduction Planner can help you set up a pay-
ment plan so you’ll pay the least amount of interest and be debt-
free as soon as possible.

Quicken searches your data for debts (such as liability accounts 
and credit card accounts) and sorts them, putting the most expen-
sive debt at the top of the list (it’s the one with the highest interest 
rate). For each debt, enter your current payment and the monthly 
minimum you need to pay. 

Follow the payment plan Quicken calculates to pay off the most 
expensive loan first, while paying the minimum on your other 
debts. (The Debt Reduction Planner takes into account whether 
interest on a debt is tax deductible when it calculates a payment 
plan.) After you pay off the most expensive debt, take the money 
you have been paying on the first loan and add it to the mini-
mum payment on the second debt. Thus without increasing the 
amount you pay each month, you’re paying the least amount 
of interest. 

If you can’t pay your bill in full each month, look for a card with 
no annual fee and the lowest interest rate (and not just the lowest 
initial rate). To search for a lower rate, from the credit card 
account Overview page, click “Search for lower rates online.”

To start the Debt 
Reduction 
Planner
From the Planning menu, 
choose Debt Reduction.

Quicken analyzes your debts 
and lists the order in which 
you should pay them off in 
order to pay the least amount 
of interest and be debt free in 
the shortest amount of time.
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Track your cash withdrawals 

For some people, ATM cards cause almost as much trouble as 
credit cards. Do you sometimes forget to enter ATM withdraw-
als? Do you know where you’re spending all that cash?

The most thorough way to track ATM withdrawals is to create a 
Quicken cash account. Track each withdrawal as a transfer from 
your checking account to your cash account; then enter individ-
ual purchases in the cash account. To save time, you can track just 
the major transactions, then enter an adjustment to cover miscel-
laneous expenses.

To create a 
cash account
From the Finance menu, 
choose Account List, and 
then click New. Choose 
Cash as the account type 
and click Next. Follow the 
EasyStep instructions to set 
up the account.To learn about...  Search the Help Index for...

creating and using a cash 
account

cash, accounts

managing cash cash, tracking

matching cash on hand with 
the cash account balance

cash, balances

entering a transaction with 
multiple categories

categories, assigning to transactions
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Is there a painless way to cut expenses?
Budgeting doesn’t have to mean you put the handcuffs on your 
spending. Think of it as a tool to help you make the trade-offs 
that will get you where you want to go. And you can’t make 
trade-offs on your spending unless you have all the facts. You 
know how much money you take home every month. Can you 
account for where it all goes? 

First take a snapshot
Create a cash flow report to summarize your income and 
expenses by category. 

To create a 
cash flow report
From the Reports menu, 
choose Reports and Graphs 
Center, and then choose 
“Easy answer reports and 
graphs.” Select “Where did I 
spend my money during the 
period ... ?”, and then click 
Show Report. To display just 
the spending categories that 
are of interest, click Custom-
ize. Then click the Include 
tab and select the categories 
you want to zero in on (din-
ing out, entertainment, and 
other discretionary spend-
ing categories are a good 
place to start).

Create a cash flow 
report to show just 
the categories you 
want to track 
closely. 

You can double-
click the Dining 
category amount 
to see a list of all 
transactions 
you’ve assigned 
to the category 
“Dining.”
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Target high spending areas

Using the Quicken budgeting tool, you can zero in on a few cate-
gories you’d like to spend less on, such as your dining expenses. 
By cutting down on dining and other discretionary spending 
areas, you’ll have more money to put aside for your savings.

Track where you overspend

Use a Budget Goal Progress Bar to monitor a category in which 
you typically overspend. You can display a Progress Bar on the 
My Finances Center. 

How can I save more?
The Life Events planning tools prepare you to save more. From 
the Planning Center click:

■ How can I get out of debt?

■ Can I afford this purchase?

■ How can I save more money?

Once you are in a position to begin saving money, Quicken 
can help.

To create a 
budget
From the Planning menu, 
choose Budgeting. Click 
Categories to select the areas 
you want to focus on.

It can be 
helpful to 
concentrate 
on your 
discretionary 
spending 
categories.

To create or 
change a Budget 
Goal Progress Bar
From the My Finances Cen-
ter, click Customize, and 
then Customize this View. 
From the Available Items 
list, select Budget Goal 
Progress, and then
click Add.

To change the budget item 
or group that you are track-
ing, place your cursor over 
the Progress Bar and click 
the right mouse button. 
Select Customize this 
Graph.
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Start by transferring a portion of your paycheck every month to a 
savings or other interest-bearing account. The most straightfor-
ward method to manage savings in Quicken is to set up that 
transfer as a scheduled transaction. If you have not yet set up 
online banking, the scheduled transaction in Quicken can serve 
as a reminder to contact your financial institution to make the 
transfer in your actual accounts. If you do have online banking, 
the transfer will take place the next time you update your 
accounts online. 

After you have taken care of debts and created a prudent reserve, 
Quicken can help you do the important work of meeting your 
long-term savings goals. To get started, See “How should I invest 
to achieve my goals?” on page 65.

To schedule a 
transaction
From the Finance menu, 
choose Financial Calendar. 
In the Financial Calendar’s 
Transaction list, click to 
select the transaction you 
want to schedule for recur-
ring payments, then drag it 
to a date on the calendar. If 
you are entering a new 
transaction, click and drag 
the entry marked “Use this 
for a NEW one!”

Use a scheduled 
transaction to 
transfer $200.00 
from your 
checking account
to your savings 
account on a 
regular basis.
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O W N  A  H O M E
Should I buy a home? 38

Am I ready to buy? 39

Can I afford that house? 40

Where can I find 
the right loan? 41

How should I track 
my home in Quicken? 43

When should I refinance? 45

What happens when I sell? 47

How can I safeguard 
my investment? 50

Are we ready 
for home 
ownership?
A home of your own is part of the 

American dream. It can be a tax break, 

a savings vehicle, and low-cost 

housing for your retirement. The 

question is, can you afford to buy and 

maintain one? 
37



Should I buy a home?

For most people, owning a home is the cornerstone of their 
long-term financial plan. It is probably the biggest purchase 
you’ll ever make, but eventually you’ll pay off the mortgage and 
substantially lower your housing costs in retirement. In the 
meantime, your home equity can serve as collateral when you 
need a loan, and the tax breaks begin immediately. 

Buying versus renting

Neither is a bad choice, depending on where you are financially 
and what your needs are.

Renting: Owning:
■ Economic flexibility: You 

can upgrade or downgrade 
your housing as your cir-
cumstances require.

■ Economic freedom: Your 
money is available to invest 
elsewhere.

■ Geographic freedom: You 
can move when your lease 
expires or converts to 
month-to-month.

■ Less commitment: You 
don’t worry about upkeep 
or long-term property value.

■ Great tax breaks: You can 
deduct property taxes and 
interest on a home loan of 
up to one million dollars.

■ $250,000 exclusion: You can 
exclude up to $250,000 
($500,000 for married cou-
ples filing jointly) capital 
gains when you sell.

■ Appreciation: Homes have 
historically appreciated in 
value faster than the cost of 
living in general. You build 
equity even before you own 
the home free and clear. 

■ Equity: If you need a second 
loan, your home can serve as 
collateral. 
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Am I ready to buy?
Expect to pay 10 to 20 percent of your home’s purchase price as a 
down payment. To figure out how much down payment you can 
afford, run a Quicken Net Worth report. For more on Net Worth 
reports, see “What is my real net worth?” on page 24.

If you put down less than 20 percent, your lender will usually 
require that you buy private mortgage insurance (PMI). You can 
cancel PMI when your equity reaches 20 percent. This is a great 
reason to track your loan and estimated home value in Quicken!

For help saving up for that down payment, see “How can I save 
more?” on page 35.

The following guidelines are commonly used by lenders to qual-
ify buyers for a home loan:

■ Your expected monthly housing costs (principal, interest, 
property taxes, and insurance) should not exceed 28 percent 
of your gross monthly income.

■ Your monthly debt (mortgage plus school loans, consumer 
debt, etc.) should not exceed 36 percent of your gross 
monthly income. 

If your consumer debt is high, use Quicken’s Debt Reduction 
Planner to reduce your debt as quickly as possible while paying 
the least amount of interest. See “Reduce your debt” on page 32.

Check your credit history

Your credit report is a valuable source of information about 
where you stand financially. Your income and credit history will 
be very important when you apply for a loan. The lender will 
want to know the number and types of credit accounts you have, 
how much you owe, how well you repay your debts, and when 
your newest accounts were opened. 

Check your credit rating regularly, especially if one of the follow-
ing applies to you:

To create a net 
worth report
From the Reports menu, 
choose Reports and Graphs 
Center. Choose “Easy 
answer reports and graphs” 
and then select “What am I 
worth?” Click Show Report.

To create a 
savings goal
From the Planning menu, 
choose Savings Goals. From 
the Savings Goals window, 
click New and then fill in 
the information. The name 
of the goal will be the name 
of the account used to track 
the savings goal.

To order a credit 
report
From the Household menu, 
choose Credit Research. Fol-
low the onscreen instruc-
tions for obtaining the 
report. You must have Inter-
net access.
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■ You are applying for a mortgage or other loan, purchasing 
insurance, applying for a new job, or applying to rent or lease 
property.

■ You are disputing an item you’ve charged on a credit card. 
(Make sure your refusal to pay is noted on the credit report.)

■ You have been refused credit on the basis of a negative 
credit report.

■ You want to make sure that no one has opened an account in 
your name.

Can I afford that house?
For an in-depth investigation into whether you can afford to buy 
a home, and how purchasing one will affect your finances, use 
the Home Purchase Live Event Planner. The planner answers crit-
ical questions about buying a home and helps you prepare to buy. 
By asking you questions about your current situation and com-
bining the answers with your Quicken data, the planner can 
help you:

■ Set up goals to save for a down payment

■ Determine the loan amount you’ll need 

■ Calculate how much you can afford to borrow, and what 
your monthly payment will be

■ Track your progress

To use the Home 
Purchase Life 
Event Planner
From the Planning Center, 
under Life Events, click 
“Can I afford that house?”
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Where can I find the right loan?
After you have found the perfect house, the hard part begins. It 
can be a daunting task to hack through the thicket of mortgage 
types and lenders available to you. For one-stop shopping, go to 
QuickenMortgage to research mortgages from the nation’s lead-
ing lenders. From there you can enter your financial data to find 
loans you qualify for, and search a nationwide data base for loans 
tailored to your preferences. Your loan search results are kept up 
to date as the market changes.

Mortgage types

Should you get a fixed-rate loan or an adjustable-rate loan? There 
are advantages and disadvantages to each.

Long-term fixed-rate loans The 30-year fixed-rate mortgage 
is the loan most people think of when they hear the word “mort-
gage.” It carries the least amount of risk, because you have a pre-
determined interest rate from the day you close escrow until the 
day you pay off the loan. If interest rates drop significantly, you 
can always refinance. (Of course, you’ll have to pay closing costs 
and points all over again. For more on refinancing, see “When 
should I refinance?” on page 45.)

To research 
mortgage rates 
and lenders
From the Household menu, 
choose Mortgage Research 
Online. You must have 
Internet access to use this 
feature.

Advantages Disadvantages
■ The predictability makes it 

easier to budget for other 
long-term needs such as 
retirement or college tuition.

■ You don’t have to worry an 
increase in your monthly 
payment every time interest 
rates fluctuate.

■ Higher interest rate 
than ARMs. 

■ If interest rates are high 
when you buy, you could be 
locking in an expensive 
loan—make sure there are 
no prepayment penalties if 
you refinance later.
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Adjustable-rate mortgages (ARMs) An ARM’s interest rate 
changes with the market. There’s usually a risk involved with 
ARMs, similar to investing in the bond market. ARMs are tied to 
an interest rate index (usually either U.S. Treasury securities or 
the Prime Rate—the cost that corporations pay to borrow from 
banks. Your interest rate changes will follow the appropriate 
index, according to the schedule in your mortgage agreement. 
Find out which index your lender uses and how many percent-
age points they add to the index rate. Some mortgages have min-
imum and maximum interest rates.

Long-term or intermediate-term loan? A 15- or 20-year loan 
usually has a lower interest rate than a 30-year loan. Your 
monthly payments may be higher than for a 30-year fixed loan, 
but you will end up owning your home outright in less time, and 
you’ll pay significantly less interest over the life of the loan. On 
the other hand, long-term loans are a good choice if you want to 
buy more house right now and plan to stay there for a long time. 
It will take longer to pay off the loan, but your monthly payment 
will be lower and you’ll probably be able to afford more house. 

Should I pay points?

The idea behind points is that you pay a percentage of the loan in 
order to “buy down” the interest rate. Each point you pay is 
equal to 1 percent of the loan amount (thus on a $200,000 loan, 
one point would be $2,000), payable when you close escrow. 

Advantages Disadvantages
■ Tend to start out at a lower 

initial cost.

■ Can be a bargain if you 
don’t expect to own your 
home for very many years.

■ Are popular among people 
who expect their income to 
rise to cover potential 
increase in monthly pay-
ment.

■ Are subject to unpredictable 
changes in interest rate, 
which may cause your 
monthly payment to rise to 
an amount you can’t afford.

■ Make sure you know what 
your “caps” are—for each 
incremental increase, and 
over the life of the loan. 
Know your schedule for 
adjustments, too.
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Should you pay points at closing, or take a higher interest rate on 
the loan? That depends. If you plan to move or refinance soon, 
points can be costly. But if you plan to stay put for a while, you 
may be better off paying the points and getting a lower interest 
rate over the life of the loan. Points may also be tax deductible, 
depending on your circumstances. 

How should I track my home in 
Quicken?
How home ownership affects net worth

Typically, when you buy a home you suddenly have one big new 
asset (the value of the home) and one big new liability (the 
amount of the loan). 

To see your complete financial picture, Quicken creates a loan 
and an associated asset account tracking the value of your home, 
beginning with the purchase price. 

By tracking the loan in Quicken you’ll see these benefits:

■ You see the amount of interest you pay each year so you can 
document the tax deduction for interest from mortgages and 
equity lines of credit.

■ You see how the loan’s outstanding balance affects your
net worth.

To set up a home 
account
From the Finance menu, 
choose Account List, and 
then click New. Choose 
House as the account type 
and click Next. Follow the 
EasyStep instructions to set 
up the house asset account 
and linked loan liability 
account.

In the Set Up Loan Payment 
window, from the Category 
for Interest pull-down 
menu, select the tax-related 
Mortgage Interest category.

This net worth 
graph shows the 
before-and-after 
picture for a family
that purchased a 
home. Both the 
assets (now 
including home 
equity) and 
liabilities 
(including the 
mortgage) have 
increased 
dramatically.
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TI P You don’t have to enter 30 years’ worth of loan pay-
ments. Just set up the loan in Quicken and then create a sched-
uled transaction to remind you to accept the payment each 
month. For more information, see “How can Quicken do the 
work for me?” on page 10. 

The difference between tracking market value and 
cost basis

When you create a net worth report, your home’s value (asset 
account) minus what you owe (liability account) equals your 
equity. After you have created an asset account for the purchase 
price of the home, you can track this value one of two ways. 

Current Market Value As you record home payments each 
month, Quicken transfers a portion of the payment to your liabil-
ity account, decreasing its balance by the amount that applies to 
principal. Thus every month you decrease your debt and increase 
your equity, and it’s reflected in your next net worth report.

Quicken can help track home equity, by updating the estimated 
market value of your home as time goes on. When you set up 
your home’s asset account, Quicken asks for your address and 
ZIP Code. Quicken can use this information to download recent 
sale prices for comparable homes in your area. From your home 
asset account’s Overview page click Home Values Download.

Adjusted Cost Basis This basically tracks the home improve-
ments you make. Every improvement you make increases the 
Cost Basis of your home. When you eventually sell, you may be 
taxed on part of your capital gains. If you can prove that part of 
the gain was due to your improvements, your taxable basis will 

To create a net 
worth report that 
shows home 
equity
From the Reports menu, 
choose Reports and Graphs 
Center. Choose “Easy 
answer reports and graphs” 
and then select “What am I 
Worth?” Click Show Report. 

In the Net Worth report 
window, click Customize. 
Then click the Accounts tab. 
You want to include only 
the asset account and liabil-
ity account, so click Clear 
All to remove the check 
marks from all accounts. 
Then select just the asset 
(home value) and liability 
accounts (outstanding mort-
gages and loans). 

Quicken displays the net 
worth report. The Overall 
Total amount is the equity 
you have in your home. 

Memorize the report and 
name it something like 
“home equity.”

Your equity equals the 
value of the home 
minus your outstanding 
loan amount.

Loan

Your down 

Rise in market value Equity

Equitypayment

Outstanding
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be reduced by that amount. (Keep those receipts!) For more 
details on tracking cost basis, see “Document home improve-
ments” on page 57.

When should I refinance?
At some point after you purchase your home, you may want to 
change the conditions of your mortgage. Before you do, consider 
the costs:

■ Points

■ Credit report

■ Appraisal

■ Title fees and other closing costs

N O T E Points from the original mortgage were deductible 
from your first year’s taxes. Refinancing points are different—the 
deduction must usually be spread out over the life of the loan. 

To learn about... Search the Help Index for...
loans and mortgages, 
including tracking, changing 
details, refinancing, types of 
loans, making payments and 
additional prepayments, and 
deleting a loan you’ve paid off

loans, using

tracking loans with semi-
annual compounding

Canada, loan amortization
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Reasons to refinance

■ If interest rates drop, you may be able to refinance and get a 
lower interest rate. Some experts suggest holding off on refi-
nancing until the interest rates drop two points or more.

■ You may need to borrow money, either to make improve-
ments on the home or for some other expense. Borrowing 
against your home can make good sense because mortgage 
interest is generally tax-deductible and the interest rates are 
usually lower than on a personal loans. But remember, your 
home is on the line, so don’t overborrow.

■ It might make sense to switch to a different kind of mortgage, 
especially if you have an adjustable-rate loan and interest 
rates have just taken a dive. If this happens, consider refi-
nancing to lock in a low fixed-rate loan.

Crunching the numbers You can use Quicken Refinance Cal-
culator to figure out if a new loan is more economical than your 
current loan.

Tracking refinancing costs in Quicken If you’ve refinanced 
your mortgage recently, you can use a Quicken asset account to 
track each year’s portion of the points. At tax time, you won’t for-
get to take the deduction, and you’ll have an easy way to track 
how much you should deduct for the mortgage cost.

First, set up an asset account in Quicken and call it something like 
“Refinance Cost.” Enter your total refinance costs as the opening 
balance, and use the date you refinanced for the date. Then create 

To check out 
mortgage rates
From the Household menu, 
choose Mortgage Research. 
You must have Internet 
access to use this feature.

To use the 
Refinance 
Calculator
From the Planning menu, 
choose Financial Calcula-
tors, and then Refinance.

Fill in the boxes in 
the calculator. 
Quicken calculates 
how long it will 
take for you to 
break even if you 
choose to 
refinance.
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an expense category for the deduction. Give it an obvious name, 
like “Refinance,” and mark it as tax-related. In the Form box, 
select Schedule-A Points Paid. 

Each year at tax time, enter a transaction (or schedule one in 
advance) in your Refinance Cost asset account. Enter something 
like “Refinance cost deduction” in the Payee field. Put the 
amount of the deduction in the Decrease column and assign the 
transaction to the Refinance expense category. 

What happens when I sell?
When you sell your home, use Quicken to track the sale-related 
expenses. Set up an expense category called “Home Sale” and 
several subcategories to track expenses. Report the expenses on 
the Home Sale worksheets to determine whether you can exclude 
all or part of the gain on the sale. 

Category name Use for Link to line item

Home Sale:sale price The total sale price to your buyer. Sale of Home, Selling price of old 
home.

Home Sale:fees Expenses associated with the sale of the 
house, such as bank fees and realtor’s 
commissions.

Sale of Home, Expense of sale.

Home Sale:fixup Expenses for repairs necessary for your 
sale. Use this category for expenses that 
fit the IRS definition of a fixing up 
expense. The expense must be incurred 
within a specific period after you sign 
the sale contract.

Sale of Home, Fixing up expenses.

The amount you realize from the sale of 
the house is your profit.

Quicken doesn’t include a line item for 
this category. This is the net deposit 
amount of the check you receive after 
closing. It will also be calculated by 
TurboTax.
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As you set up each subcategory, assign it to the appropriate line 
item on the Sale of Home worksheet.

When you close the sale on your house, some of the money will 
probably go to pay off your old mortgage, some to your realtor, 
some for bank and title fees, and some to your bank account as 
profit. An escrow company usually takes care of distributing 
these funds.

For tax purposes, you want to track where all the proceeds go. If 
you have been tracking your loan and sale expenses in Quicken:

■ Record a transaction in your Quicken checking register (or 
whatever account you choose to put the money in).

■ Split the transaction to match the distribution of the money.

You can set up a new 
category from the 
Category & Transfer 
list. From the Lists 
menu, choose 
Category/Transfer. 
Then click New.

Select the tax-related 
checkbox.

Choose the tax form 
line item here.

To find more 
information on 
closing loans
From the Help menu, 
choose Index, and enter 
loans, paying off. 
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N O T E Do this after you receive the escrow statement from 
the title company. 

■ Close out the liability account that tracked the mortgage loan 
you deleted. 
After you record the sales transaction, this liability account’s 
balance is zero. Close out the account by marking the open-
ing and closing transactions as cleared. (Click twice in the Clr 
column, telling Quicken you don’t want to reconcile.) Since 
the account is no longer active, you might want to hide it 
from your Account List. In the Account List, click Hide. 

Here’s a sample transaction.

The first split line lists the full sale 
price assigned to “Home Sale” 
category.

The second line transfers the amount
necessary to pay off the mortgage to
their mortgage liability account.

The third line assigns bank and 
realtor fees to “Home Sale:fees” 
category.
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How can I safeguard my investment?
What if the worst happens and you lose your home in a fire or 
other disaster? Your savings could disappear if you don’t have 
adequate insurance.

A brief look at insurance

Review your current policy limits. To recoup the entire loss of 
your home, your policy must cover the total replacement cost. This 
cost is the amount it would take to rebuild the house after it is 
totally destroyed. And it’s definitely to your advantage to insure 
your home and contents for at least 80 percent of their value. If 
you insure your home for less, and then incur a loss, your insur-
ance company will usually prorate its reimbursement to you.

Consider signing up for an inflation guard endorsement. It 
increases the policy limits for your coverage by a specific percent-
age on a regular basis. You may have your limits increased by one 
percent every four months to keep ahead of inflation. You still 
need to check your coverage every year, to keep up with rising 
construction costs and the value of home improvements.

Determining your insurance coverage

Quicken Home Inventory helps you figure the total value of what 
you own. 

To check your 
coverage with 
Quicken Home 
Inventory
From the Household menu, 
choose Quicken Home 
Inventory. In Quicken 
Home Inventory, from the 
View menu choose Policy 
List. Then select Home-
owner/Renter (or the pol-
icy you are assigning your 
belongings to). Click Edit. 
Enter all the information 
about your policy, including 
the full amount of your cov-
erage in the Coverage field. 
Then click OK. The Policy 
List shows the difference 
between your coverage and 
the replacement cost.

If this difference is positive, 
you’re probably adequately 
covered; if the difference is 
negative, you’re probably 
underinsured. Consider 
purchasing additional cov-
erage.

1. Select the room or 
location you want to 
inventory.

2. Then select an item category, such as 
Furnishings. The Furnishings category contains the 
greatest variety of items. 

3. Select 
items from 
the Suggested 
Items list, or 
add your 
own.
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After you’ve entered your belongings, you’ll need to record infor-
mation about your current insurance coverage. Once you’ve done 
this, Quicken Home Inventory shows you the difference between 
your insurance coverage and the replacement cost of your inven-
tory items. Be sure to store a backup disk and a printed report of 
your home inventory data in a fireproof box, or better yet, in a 
location other than your home. This safety measure can help you 
substantiate an insurance claim if your home is destroyed.

Need more information about insurance? If you need infor-
mation about insurance for your home, go online to Quicken 
InsureMarket for insurance information, decision tools, and anal-
ysis. You’ll also find current quotes for auto, home, and life insur-
ance policies. From the Household menu, choose Insurance 
Research Online. To use this feature you must have
Internet access.

TI P Besides coverage for replacement of property that is 
destroyed or damaged, you should also have insurance to cover 
your liability if someone has an accident on your property.

Know where your records and policies are located

Use Emergency Records Organizer to store all the important 
information about you, your family, and your home. Enter infor-
mation into major areas, like emergency information, personal 
and legal documents, home/auto/property, and so on. You don’t 
have to try to remember all the bits of information you’d like to 
organize and record; Quicken provides comprehensive lists of 
items that you simply fill in. Fill in as much or as little as you 
find useful. 

To create an 
insurance 
coverage report
In Quicken Home Inven-
tory, from the Reports 
menu, choose Insurance 
Coverage Summary.
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You can create reports that include just a subset of the informa-
tion, such as an emergency situation report that would be given 
to a spouse, attorney, or next of kin at the time of an emergency or 
death. You’ll even find reports useful to give your baby-sitter or 
your lawyer. You can also create a complete report that lists all 
the details you’ve entered in the Emergency Records Organizer.

To get started, enter information about yourself and then your 
family members. Next, enter any legal documents, followed by 
whatever information is of priority to you.

Update this information whenever your situation changes. You 
can make updating your records part of your routine so that 
you’re not really “done” until you’ve entered the information in 
Quicken. In an emergency, you’ll have immediate access to the 
information and the location of documents you need. Not only 
will this feature save you time, it may reduce your stress as well.

TI P Don’t forget to back up your Quicken data regularly and 
store a backup copy outside your home. 

Keep important addresses in one place

The Quicken Address Book is a great tool for organizing and stor-
ing the addresses you need when you’re paying bills or doing 
other financial chores. The Address Book creates a central list that 
you can sort, search, group, and print. You can use it to keep up-
to-date contact information for friends, family members, business 
associates, and clients.

To start 
Emergency 
Records 
Organizer
From the Household menu, 
choose Emergency Records 
Organizer. Select the Cre-
ate/Update Records tab and 
enter information about 
your home records.

To record 
information 
about you and 
your family:

Select an area 
from the drop-
down list.

Select a topic.

Enter the 
information.

To start the 
Address Book
From the Finance menu, 
choose Address Book. 

Addresses you’ve already 
entered in Quicken (at the 
Write Checks screen or for 
online payments) are added 
to Financial Address Book 
automatically.
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How can Quicken help with taxes?

You don’t need a mortgage and a hefty list of deductions to 
save on taxes. Review the tax savings ideas in these next few 
pages, and then use Quicken’s tax tools to painlessly implement 
your new strategies. 

■ Use EasyStep Paycheck Setup to track your payroll
tax deductions.

■ Identify tax-related income and expense categories so you 
can track your tax-related transactions.

■ Use Tax Link Assistant to link tax-related categories to the 
appropriate line items on federal tax forms.

■ Create Quicken reports to help fill in your tax forms.

■ Use the Quicken Tax Planner to estimate your tax bill.

■ Import your Tax Profile from TurboTax to review your pro-
jected tax situation for the current year.

■ Set up tax Alerts to notify you of important tax deadlines and 
limits, or alerts based on your TurboTax Tax Profile.

■ Use the tax planning tools to make sure you withhold the 
right amount, and to maximize your deductions. 

For more information about Quicken tax tools see page 59. 

How can I plan ahead?

Contribute to retirement accounts

Contributing to a retirement account such as a 401(k), 403(b), or 
traditional IRA is a great way to reduce your tax bill and prepare 
for a financially secure future at the same time. When you put 
money in a retirement account, the funds compound, tax-
deferred, until you withdraw them. With certain restrictions, you 
won’t have to pay tax on the money you contribute to a tradi-
tional IRA or 401(k) plan, or its earnings, until you withdraw 
money from the plan. When you retire, you may be in a lower tax 
bracket, in which case the taxes you pay on the money could
be reduced. 

To access the 
Quicken tax tools
From the Taxes menu, 
choose Tax Center.

To get late-
breaking tax rules
From the Finance menu, 
choose Quicken on the Web, 
and then Quicken.com. Go 
to the Taxes area for the lat-
est Intuit Internet tax tools 
and resources. To use this 
feature, you must have 
Internet access.
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On the other hand, if you invest in a taxable bank certificate of 
deposit (CD) or stock mutual fund, your interest or dividends are 
usually taxable on your current year’s tax return. And if you sell 
stocks and mutual funds at a gain, the gain is also taxable. 

Withdrawals from tax-deferred accounts usually have a penalty 
if you withdraw before age 59-1/2, so use this only to fund your 
long-term goals. For more information on tax-saving retirement 
investments, see “Start with retirement accounts” on page 67. 

N O T E Roth IRAs differ from traditional IRAs in that you 
invest after-tax dollars, so they do not affect your current tax. For 
more information, see “Individual Retirement Account (IRA)” on 
page 68.

Quicken can help track your 401(k)

Track your 401(k) using the Quicken EasyStep 401(k) feature, and 
then use the EasyStep Paycheck Setup to track 
your contributions. 

For more information on payroll deductions, see “Track your 
payroll deductions” on page 60. 

Use your employer’s flexible spending plan 
If your employer offers special “flexible spending” plans, con-
sider taking advantage. These plans allow you to set aside a cer-
tain amount of your pretax earnings to use throughout the year 

To use EasyStep 
401(k)
From the Investing menu, 
choose Investing Activities, 
and then Track 401(k).

The Quicken 
401(k) view 
window lets you 
see your 401(k) 
portfolio in several 
ways. 
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to pay a specific expense such as medical, childcare, or other 
insurance expenses. Your take-home pay will be slightly less if 
you sign up for a flex account, but if you’re going to spend this 
money anyway on the associated expense, you might as well pay 
with cheaper, pretax dollars.

The challenge is to estimate how much you typically spend in the 
appropriate category (create a category report from the Reports 
& Graphs Center), and track the amount you put aside, because 
you usually have to use all the money you put in the account by 
the end of the year, or in most cases you lose it. 

Quicken can help track your flex account

Create an asset account to track your flexible spending funds.

Enter your flex account contributions as a transfer in the 
EasyStep Paycheck Setup. See page 60 for more information.

When you receive a check from your flexible spending account to 
cover your expenses, deposit the check in your checking account. 
Then enter the transaction in Quicken, creating a transfer in the 
Category field from the flexible spending asset account to your 
checking account. This transfer decreases the balance in your 
flexible spending asset account.

Give the account a meaningful 
name (in this case, Flex 
childcare).

If you are starting mid-year, enter 
the amount your employer has 
already deducted.

Don’t select the tax-deferred 
checkbox.

Select the tax schedule for 
transfers in. 

Do not select a tax schedule for 
transfers out.

Record the amount 
you set aside from 
each paycheck as a 
transfer to the flexible 
spending account. 
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Keep taxes in mind when you invest

Your investment decisions can have an affect on taxes. For exam-
ple, all things being equal, investing in tax-exempt vehicles can 
save you a bundle. Say you have $10,000 to invest. Should you 
put it in an investment with tax-exempt interest income yielding 
4.5%, or an investment with a higher yield of taxable interest 
income? Depending on your tax bracket, the investment with the 
lower yield could actually give you more net earnings after taxes. 
If you are in the 31% tax bracket, a 4.5% yield exempt from fed-
eral tax is actually equivalent to a taxable yield of 6.52%. 

When buying or selling securities, use the Capital Gains Estima-
tor to find a tax-wise sales scenario before you sell. For more 
information, see “Reduce your capital gains tax” on page 63.

How can I maximize my deductions?

Take all your homeowner deductions
If you own your home, you may be living in your largest tax 
deduction. Subject to limitations, the interest you pay on your 
loan is tax deductible. Points, also called a “loan origination fee,” 
may also be deductible. Points you pay on the original mortgage 
are deductible in the year you take out the loan. Refinance points 
can be spread out over the life of the loan. For more information, 
see “How should I track my home in Quicken?” on page 43, or 
click “How can I maximize my deductions?” in the Tax Center. 

Document home improvements When you sell your home 
you are taxed on the difference between the sales price and your 
original purchase price plus improvements. Generally, the more 
improvements you can document, the lower your taxable gain . 

An improvement to your home increases your cost basis if it 
increases the value of the property, lengthens its life, or adapts it 
to a different use. Examples would be rewiring your home, land-
scaping, or installing new plumbing. It does not include mainte-
nance such as painting or carpet cleaning. You may exclude from 
your taxable income up to $250,000 gained from the sale of a 

To find your tax 
bracket
From the Taxes menu, 
choose Tax Planner. From 
the drop-down lists, select 
your filing status and tax 
year. Enter your wages and 
salaries as well as the appro-
priate exemptions and 
deductions. Your marginal 
and average tax rate are dis-
played in the right column. 

Note: If you imported your 
Tax Profile from TurboTax, 
Quicken will fill in some 
data for you. For more infor-
mation, from the Help menu 
choose Index, and enter
tax profile.
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principal residence ($500,000, for married persons filing jointly). 
Check with your tax adviser, and keep receipts. 

For more on tracking cost basis, see “The difference between 
tracking market value and cost basis” on page 44.

Convert consumer debt to tax-deductible debt If you are 
paying a lot of interest on a credit card or auto loan, consider bor-
rowing against your home equity to pay off the amount you owe. 
You’ll still have to pay the debt, but the interest rate is generally 
lower on home equity loans and it’s also usually tax-deductible. 
Just be careful not to get in over your head—you’ll still need to 
pay off the home equity debt, and your home is on the line, too. 

Deduct other taxes you pay

Some of the other taxes you pay are deductible on your federal 
tax return, including these:

■ State and local income taxes

■ Real estate taxes, minus any city services fees 

■ Foreign income taxes

■ State and local personal property taxes (such as for your car)

■ Taxes that are expenses of your trade or business

■ One-half of self-employment tax

■ Taxes on property producing rental income

■ Occupational taxes

Your capital gain
Your increased 

cost basis

Your selling price

Your improvements to the 
house (save those receipts!)

Your purchase price (includes 
original loan amount)

(This assumes the homeowner 
has not deferred the gain from a 
previous home or refinanced 
this home for an amount larger 
than the original loan.)

$120,000

$150,000
$210,000
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Keep track of charitable contributions

Donations to qualified organizations are deductible, whether the 
donation is cash or a donation of clothing, household goods, or 
automobiles. Check with the organization to find out if it is a 
qualified nonprofit organization. 

You need a written receipt for donations of clothing, household 
goods, or automobiles, or cash donations over $250. Remember 
that you can deduct only the fair market value of a donated 
item—not the price you paid for it.

If you do volunteer work for a qualified organization, you can 
deduct your out-of-pocket expenses, such as mileage. Keep a 
mileage log that lists the date and purpose of the trip, with the 
number of miles driven. At the end of the year, check the IRS rate 
for volunteer work mileage and multiply it by the number of 
miles you drove.

Consider donations of appreciated stocks. If you have held them 
for longer than 12 months, then you can deduct the full market 
value of the donation, without realizing the gain.

N O T E If you have enough expenses to itemize, set the 
Quicken Tax Alerts for charitable contributions. Near the end of 
the year, Quicken reminds you to maximize your contributions. 
From the Finance menu, choose Alerts. In the Set Up Alerts win-
dow, click the Taxes tab.

How do I set up Quicken tax categories?
Now that you’ve had a chance to review some ways to cut your 
tax bill, you need to set up Quicken to help you achieve this goal. 
Once you’ve set up your accounts and categories to help you 
track tax-related transactions, the most tedious part of tax prepa-
ration will be taken care of. To see the overview of your tax pic-
ture, open the Quicken Tax Center. The Tax Center provides 
access to the Quicken tax tools, along with tax tips, important 
dates, and summary information about your tax-related Quicken 
data. You can also set Alerts based on your own tax data, and, if 

To determine fair 
market value of 
donations
To determine fair market 
value, call the IRS at 1-800-
TAX-FORM and ask for IRS 
publication number 561. If 
you have Internet access, 
you can download many 
IRS publications and forms 
from the IRS Web site. See 
www.irs.ustreas.gov.

To open the Tax 
Center
From the Taxes menu, 
choose Tax Center. 
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you have Internet access, the Tax Center displays links to
Web resources.

Track your payroll deductions

If you track your wages and payroll taxes, Quicken can project 
your tax situation for the current year in the Tax Planner. The 
EasyStep Paycheck Setup makes it easy. From the Banking menu, 
choose Banking Activities, and then “Set up my paycheck as a 
register transaction.” 

Identify tax-related categories

Set up categories so you can track your tax-related transactions. 
When you add or edit a category in the Category/Transfer List, 
identify it as tax-related and then assign the federal tax form 
and line

Enter all the information you’d like 
to track in the EasyStep Paycheck 
windows. 

Then Quicken creates a split 
transaction in your checking 
register. If you create a scheduled 
transaction, Quicken can enter the 
memorized transaction for you on 
payday. 

You can edit this transaction if the 
amounts change next time you 
enter a paycheck deposit.
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Match Quicken categories to IRS tax forms

Use the Quicken Tax Link Assistant to assign your categories to 
tax forms and lines all at once.

TI P If you have recently married or purchased a home, you 
can add ready-made tax-related categories specific to those situa-
tions. In the Category & Transfer List, click Options and then 
choose Add Categories.

To display the 
Category list
From the Finance menu, 
choose Category/Transfer 
List.

Click Options and select 
Show Tax Item to review the 
linked categories and tax 
forms.

Quicken has already set up 
some categories for taxes. 
Add or edit categories you 
need to complete your tax 
picture.

Mark them as tax related and 
select the tax form and line 
from the drop-down list.

To start Tax Link 
Assistant
From the Taxes menu, 
choose Tax Link Assistant. 

For more information, from 
the Help menu, choose 
Index, and enter taxes, 
assigning to line items.

Select a Quicken 
category and then 
select the appropriate 
tax form line item 
from the list on the 
right. Click Assign 
Line Item to Category.

A brief description of 
the tax form line item 
appears below. 

You can also select 
the tax form line item 
when you set up the 
category (see the 
example above).
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How do the Quicken tax tools work?
Quicken can help you find deductions
The Quicken Tax Deduction Finder helps you find tax deductions 
that you may have missed. Be sure to investigate any deduction 
thoroughly before you take it. Tax Deduction Finder can only 
help you identify deductions you may have missed; it can’t 
assess your personal situation or identify a qualifying nonprofit 
organization. Check with the Internal Revenue Service or your 
tax expert for complete details.

Create reports that help with your tax return
The Tax schedule report (and capital gains report) group and 
subtotal your transactions by tax schedule line item. Use this to 
double-check the categories you import into TurboTax. 

To start Tax 
Deduction Finder
From the Taxes menu, 
choose Deduction Finder. 
Choose a deduction type 
and then answer a few ques-
tions. The Deduction Finder 
lets you know whether or 
not the deduction might be 
available to you.

Have you taken 
courses to 
update your 
work skills? 
Quicken can set 
up a new tax-
related category 
to track your 
educational 
expenses.

To create a tax 
report
From the Reports menu, 
choose “What is my tax situ-
ation?”, and then select Tax 
Summary, Capital Gains, or 
Tax Schedule. Click 
Create Now.
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The Tax summary report groups and subtotal transactions in 
your accounts by tax-related categories. Use this report if you feel 
your taxes are fairly straightforward and you don’t want to use 
tax preparation software.

Estimate your tax bill anytime
Use the Tax Planner throughout the year to estimate your tax bill 
and determine whether you’re withholding the right amount. 
Import data from TurboTax to create a personalized tax profile. 
For more information, see “Importing a Tax Profile into Quicken” 
on page 64. 

Reduce your capital gains tax
Quicken can help you run scenarios for selling securities that 
could reduce your capital gains, and thus your tax burden. From 
the Investing menu, choose Capital Gains Estimator. In the Capi-
tal Gains Estimator window, you can enter different hypothetical 
sales of the various lots you own of a security. Since each lot was 
purchased at a different date and price, your prospective profit 
from the sale (and thus your tax burden), will probably be differ-
ent depending on which lot you sell. Compare the gain and esti-
mated tax from each sales scenario to create a sales scenario that 
yields the highest after-tax gain. 

For a report that includes your other capital gains not in this sce-
nario, click Report and select Capital Gains Report. For a more 
complete tax picture, click Tax Planner.

To display the 
Tax Planner
From the Taxes menu, 
choose Tax Planner.

Use the Tax Planner to 
estimate your tax liability. 
It can use your Quicken 
data or data you import 
from TurboTax to project 
totals for the year. 

The Tax Planner can help 
you calculate the optimal 
number of withholdings 
given your income and 
tax liability. Enter your 
current taxable pay and 
withholdings, then click 
Recommend.
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Using Quicken with TurboTax

Using TurboTax Consider using Intuit’s TurboTax tax prepara-
tion software. TurboTax guides you through complex IRS forms 
using a simple question-and-answer format. It also provides in-
product help to assist you every step of the way. You can access a 
Web-based version from within Quicken. From the Taxes menu, 
choose WebTurboTax.

If you assign tax-related categories to tax form lines in Quicken, 
you can import transactions with these categories directly 
into TurboTax.

Importing a Tax Profile into Quicken f you used TurboTax 
for your most recent tax return, Quicken can use your TurboTax 
data file to create a personalized tax profile. From the Taxes 
menu, choose Tax Activities, and then choose “Import personal 
profile from TurboTax.” 

Quicken creates a personal tax profile and then uses it in Quicken 
tax planning tools to project tax calculations for the current year. 
In the Tax Center, click “How can I maximize my deductions?” or 
“Am I over or under withholding?” You can edit this information 
if necessary from the Tax Center. Just click “View my Tax Profile.” 
This profile does not affect your Quicken data. 

If you own a small business

Consider purchasing Quicken Home & Business to track your 
small business finances, as well as your home finances. Quicken 
Home & Business has additional tax tools for the small business 
owner. From the Help menu, choose Intuit Business Solutions. 

More good ideas from Quicken
The Tax Center provides planning tools to help with your tax sit-
uation. From the Taxes menu, choose Tax Center, and then click:

■ How can I maximize my tax deductions?

■ Am I over or under withholding?

To prepare your 
records
See IRS Publication 17, Tax 
Guide for Individuals, for 
explanations of tax laws, as 
well as descriptions of 
deductions and the docu-
mentation they require. If 
you have Internet access, 
you can download many 
IRS publications and forms 
from the IRS Web site. See 
www.irs.ustreas.gov.

To set up a tax 
Alert 
From the Finance menu, 
choose Alerts. Click the 
Taxes tab and select an Alert 
type in the left column. For 
some Alerts you can set a 
limit in the right column 
that will tell you when you 
reach a specified date or dol-
lar amount. 
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How should 
I invest to 
achieve my 
goals?
Investing can play an important role 

in achieving your financial goals, but 

it involves some risk. This chapter 

describes tools that can help you 

balance the risk against the possible 

return to make smart investing 

decisions, and then track the results. 

You’ll also find a world of online 

resources—these pages are just the 

beginning.
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Long-term, investing is the best way to combat inflation, your 
biggest obstacle to achieving a long-term savings goal. Histori-
cally, the stock market has outperformed any other savings vehi-
cle. Between 1946-1995, the average annualized return over a 
five-year period for the Standard & Poor’s 500 stock index was 
11.9 percent. This kind of performance sure beats a savings 
account. But these returns don’t come without a cost, and the cost 
is risk. 

Am I ready to invest?
Before you jump on the investments bandwagon, make sure 
you’ve got your short-term bases covered:

■ Pay off credit card and consumer debt.

Consumer debt usually carries a comparatively high interest 
rate and is not tax-deductible. Look at the interest charges on 
your consumer debt compared to the after-tax rate of return 
you would expect to earn on an investment. You’ll see 
quicker increase in your overall net worth if you reduce debt 
before you try to make a killing on a hot investment.

Use the Quicken Debt Reduction Planner to pay down debt 
while incurring the least amount of total finance charges. See 
“Reduce your debt” on page 32.

■ Set aside an emergency reserve. 

Financial planners suggest having an emergency reserve of 
three to six months’ worth of living expenses, even more if 
you are self-employed. Put this in a low-risk investment such 
as a money market fund or a liquid CD, which you can access 
quickly if you suffer a financial setback. If you use a money 
market fund, track it in a Quicken money market account; for 
CDs, use an asset account or “other” investment account and 
when prompted for securities, choose CD. 

For more on emergency reserves, see “Am I covering my 
bases?” on page 27.

To set up an 
emergency 
reserve
To create an Emergency 
Reserve, use the Savings 
Analysis snapshot on the 
My Finances Center. From 
the My Finances Center, 
click Customize, and then 
choose Customize This 
View. In the Customize win-
dow, under Available Items, 
select Savings Analysis, and 
then click Add to move it to 
Chosen Items. Click OK. 

From the Savings Analysis 
snapshot, click Customize 
This Report. In the Custom-
ize Savings window, click 
Emergency Fund, and then 
select an account to use as 
your Emergency Fund. 
Click OK. 
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Where do I start investing?
Start with retirement accounts

What if there were an investment with a guaranteed savings of 15 
to 39.6 percent on the day you invest? It’s called a tax-deferred 
retirement account and no matter what your financial situation, 
this is where you should start. Retirement accounts help you save 
for your most pressing long-term need, the day when your 
income stops coming in. 

These accounts jump-start your savings through a tax deferral. 
You deposit money pretax (depending on your tax bracket, this 
money is worth 15 to 39.6 percent more than if you had to pay tax 
on it first). Your money sits in the retirement account quietly 
building capital for years or decades, until the day you withdraw 
it. By then you will have retired, and your tax rates may be lower. 
Your savings have increased, while your tax liability has 
decreased. This is a winning formula.

Which plans are you eligible for? Check the table below:

To estimate your 
retirement 
savings needs
From the Planning menu, 
choose Financial Calcula-
tors, and then Retirement.

This is a quick calculator. To 
create a comprehensive 
plan, see “Check-up: Am I 
on track for retirement?” on 
page 70.

Retirement plan Who’s eligible

401(k) Employees of for-profit 
companies, some nonprofit 
employees

403(b) Nonprofit and public sector 
employees

IRA ■ Tax deferred for employees 
without an employer-spon-
sored retirement plan, or 
employees with a plan mak-
ing less than $30,000 
($50,000 for married filing 
jointly).

■ Non-tax-deferred for all oth-
ers. 
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401(k) plan These retirement plans are offered by for-profit 
companies, and some nonprofits. You can save up to $10,000 per 
year depending on your salary. Your employer may contribute to 
your account or match what you contribute, in which case you 
are even better off. Unlike pensions, these plans often give you 
freedom to make investment choices, as well as portability to roll 
over your “vested” savings if you leave your employer. Different 
plans have different vesting criteria, so check with your plan 
administrator. Some plans allow you to take out a loan against 
your savings. 

403(b) plan This is the public sector equivalent to the famous 
401(k) plan. Like the 401(k), your maximum contribution is 
$10,000, and your employer may match part of your contribution. 
You have the freedom to decide where to invest, although some-
what less than in a 401(k), and you can roll over vested funds if 
you leave your employer.

N O T E Plans vary, so check with your 401(k) or 403(b) plan 
administrator for contribution limits, available funding vehicles, 
employer matching funds, vesting criteria, and loan provisions. 

Individual Retirement Account (IRA) What if your employer 
doesn’t offer a tax-deferred retirement plan? With some restric-
tions, you can contribute up to $2,000 per year, tax-deferred, to an 
IRA for any year during which you receive any taxable compen-
sation and you are not over 70-1/2 years of age. 

Simplified Employee Pension 
Plan (SEP-IRA) 

■ Self-employed people

■ Anyone with self-employ-
ment income

■ Employees of small busi-
nesses (up to ten employees)

SIMPLE Retirement Plan Employees of small businesses 
(up to 100 employees)

Retirement plan Who’s eligible

To track your 
401(k)
From the Investing menu, 
choose Investing Activities, 
and then Track 401(k). 

To learn how to 
track an IRA or 
Keogh
From the Help menu, 
choose Index, and enter 
investments, setting up. 
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Even if your employer does have a retirement plan, you can con-
tribute tax-deferred to an IRA if you make less than $30,000 
($50,000 for a married couple filing jointly). 

You can still contribute if you don’t meet either of these criteria; 
you just can’t take the tax deduction. The earnings from your 
account are not taxed, though, until you withdraw them.

N O T E Education IRAs and Roth IRAs have different restric-
tions from traditional IRAs. To learn the basics about Roth and 
other IRAs, check out the latest on Quicken.com. From the 
Finance menu, choose Quicken On the Web, and then 
Quicken.com. Then go to the Retirement area. Roth IRAs differ 
from traditional IRAs in that you invest after-tax dollars. When 
you retire, the qualified distributions are tax-free, meaning you 
could potentially increase your income without going into a 
higher tax bracket. Consult your tax advisor to see which plan is 
best for you. 

Simplified Employee Pension Plan, (SEP-IRA), SIMPLE 
Retirement Plan If you are self-employed, or have any self-
employment income, you can set up a SEP-IRA. Employers with 
one to ten employees, may choose to set up a SEP plan for their 
employees. This plan requires the least amount of paperwork for 
the employer and offers the greatest amount of flexibility, 
because employers can vary their contribution as business condi-
tions dictate. The chief advantage to the employee is that they 
have a very high contribution limit—up to $30,000 or 15 percent 
of your compensation, whichever is less.

The SIMPLE-IRA is for slightly larger businesses, with 100 
employees or fewer. The eligibility requirements are similar to a 
SEP-IRA but offer less flexiblity for the employer. The employer 
must contribute either two percent of compensation for all 
employees, or match the employee contribution for all employees 
who contribute, up to three percent of compensation, to a $6,000 
maximum. Your employee maximum contribution is $6,000. 

Keogh Plans Keogh plans are for self-employed people, part-
nerships, and small companies. Like the SEP-IRA and SIMPLE-

To learn more 
IRAs and SEPs
See IRS Publication 590, 
Individual Retirement 
Arrangements. If you have 
Internet access, you can 
download many IRS publi-
cations and forms from the 
IRS Web site. See http://
www.irs.ustreas.gov.
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IRA plans, they offer a great deal of flexibility to the small busi-
ness owner and to the employee or self-employed person. They 
have contribution limits, and you have the freedom to vary your 
contributions each year. 

Quicken can help

Quicken can help you track your retirement accounts and update 
their value over time. From the Finance menu, choose Account 
List, and then click New. Choose an investment account type and 
click Next. Follow the EasyStep instructions to set up the account.

Check-up: Am I on track for retirement?

It’s impossible to predict the future, but the Quicken Retirement 
Planner can help you calculate variables such as inflation and 
annual return on investment to come up with a realistic plan for 
your future. Use the Retirement Planner to see whether your 
retirement plan is on track and, if not, how you can make the nec-
essary changes to provide for your future. After you create a 
plan, track your progress from the Planning Center. And when 
your circumstances change, create What-If scenarios to see how 
new financial goals will affect your plan.

 

To create a 
financial plan for 
retirement
From the Planning Center, 
under Life Events, click Can 
afford to I retire when I want 
to? Follow the simple 
onscreen directions to calcu-
late the income and savings 
you’ll need, as well as the 
effect of taxes and inflation. 

Suppose you are 35 years old and have saved $10,000 towards 
retirement. You plan to contribute $3,000 a year to your retirement 
plan. If you retire at age 67, you’ll have over $519,000 for retirement.
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How much risk should I take?
Assess your risk tolerance Investing should be based on 
research and informed decision-making, but it does carry risk. 
How much risk are you willing to accept? If you know you will 
lose sleep every time the market hiccups, keep that in mind when 
you create an asset allocation plan.

You need to take some risk In general, as you lower your 
risk, investing in bonds and guaranteed savings vehicles, you 
also lower your potential return. For example, many people 
make the mistake of putting too much of their 401(k) savings in 
guaranteed income contracts (GICs). While the principal is guar-
anteed on these investments, over the long haul you are not likely 
to receive the return you need to beat inflation and fund a long-
term goal. 

Time is your friend Generally speaking, the longer your time 
frame, the more risk you can bear. If you are starting out in life, 
time is on your side. Generally speaking, you should be investing 
primarily in stocks in order to maximize your return. As you near 
retirement, it’s time to reduce your risk, moving some of your 
investments out of securities. The same applies if you are invest-
ing for a near-term goal, such as a down payment on a house.

To fund a long-term goal, such as a young child’s education, 
you’d probably want to invest the majority of funds in stock 
mutual funds (index funds and growth funds) some in foreign 
stocks, and so on. Then as freshman year approaches, gradually 
move your investments to less volatile alternatives.

Spread your risk through careful asset allocation How can 
you put these pieces together into a plan? How can you balance 
long-term and short-term goals, weigh the risk you should take 
so that your money grows, and protect your investments from 
market fluctuations? The answer is diversification. If you spread 
your investments over both bonds and securities, and buy securi-
ties distributed over several industries, you reduce the likelihood 
that they are all going to suffer from market fluctuations during 
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the same period. The particular mixture of investments you 
choose is called your asset allocation. 

Quicken can help

There’s no one investment plan that is right for everyone. For 
help creating an asset allocation that answers your financial situ-
ation, use the Quicken asset allocation planning tool. From the 
Investing Center, click “How should I invest my money?”, and 
then follow the onscreen instructions.

Should I invest in securities?
When you are ready to invest in securities, there are basically two 
main options:

■ Research and buy individual securities.

■ Purchase a mutual fund, which is a package of securities 
managed by an investment company.

Mutual funds: A very good place to start

A smart way to diversify your investments is to buy mutual 
funds. When you buy into a mutual fund you are combining 
resources with other investors like yourself to buy a broader 
range of investments than any individual could typically afford. 
These funds have a professional manager who is responsible 
choosing investments and buying and selling for maximum 
return (or tax savings, or any number of possible investment 
goals). You are paying internal expenses associated with profes-

To download 
asset classes
If you have Internet access 
and enter ticker symbols for 
your holdings, you can 
download asset classes for 
securities and asset class 
mixes for mutual funds. 
From the Security Detail 
View, click Update, and 
then Get Asset Classes.

The asset allocation 
planner helps you 
spread your 
investment risk in a 
way that is right for 
your financial 
situation. You create 
a plan based on 
your risk tolerance, 
time frame, and 
personal financial 
goals. 

To create an asset 
allocation graph
If you’ve assigned or down-
loaded an asset class to each 
security or mutual fund in 
your Quicken investment 
accounts, you can create an 
asset allocation graph. 

From the Reports menu, 
choose Reports and Graphs 
Center. Choose “How are 
my investments doing?” 
and then select Investment 
Asset Allocation Graph. 
Choose a time period and 
click Create Now.
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sional management, though, so research the load and manage-
ment costs and weigh them against the expected returns. 

Research and analyze stocks and mutual funds

There are literally thousands of stocks and mutual funds to 
choose from, each answering a different investment need, from 
high growth to high income, from high risk to low risk, to every-
thing in between. Fortunately, Quicken can help you find the 
ones that meet your needs. You can create a list of funds that 
meets the risk and return limits you have in mind, see a detailed 
summary of each fund’s performance, and understand a fund’s 
fee structure.

To research 
stocks and mutual 
funds
From the Investing 
menu, choose Investment 
Research. 

Use these tools to screen 
stocks and mutual funds 
using a variety of strategies 
and based on the invest-
ment criteria important to 
you. You must have Internet 
access to use these tools.

The Investment Search 
Tools offer several popular 
screening tools to help you 
find the stocks that fit your 
investment needs. 
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What’s the easiest way to track my 
investments?

Create investments accounts in Quicken

You can create a Quicken investment account to track virtually 
any kind of real-world investment.

To create a 
new account
From the Finance menu, 
choose Account List, and 
then click New. Choose an 
account type and click Next. 
Follow the EasyStep instruc-
tions to set up the account.

For this kind of 
investment

Create this kind of 
Quicken account

Money market fund Money market account

Certificate of deposit Asset account or Other 
investment account (when 
prompted to add securities, 
choose CD)

401(k) or 403(b) 401(k)

IRA or Keogh IRA account, then choose type:

■ Standard IRA 

■ Roth IRA 

■ Education IRA 

■ Keogh

■ SEP-IRA

Brokerage account, containing 
stocks, bonds, and mutual funds

Regular (brokerage) investment 
account for the securities. If you 
write checks against the account, 
create a checking account when 
prompted for a linked account. 

Dividend Reinvestment Plan 
brokerage account

Dividend Reinvestment Plan 
account

Mutual fund account Single mutual fund investment 
(a separate account for each 
mutual fund)
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Use EasyAction forms to enter
investment transactions

EasyActions forms are an easy way to enter investment transac-
tions. Suppose you just bought 100 shares of Intuit stock. To 
record this transaction, open your investment register and click 
EasyActions. Choose Buy/Add Shares to enter your purchase.

Mutual fund account that has no 
cash balance

Regular (brokerage) investment 
account. When prompted for the 
kind of securities, choose “One 
mutual fund.”

Treasury bills, fixed annuities  Other investment account 

Collectibles, precious metals Asset account

Variable annuities Other investment account

Real estate Asset account

Real estate investment trusts 
(REITs)

Regular (brokerage) investment 
account

Employee stock options Regular (brokerage) investment 
account. When prompted for the 
kind of securities, choose 
“Employee stock options.”

For this kind of 
investment

Create this kind of 
Quicken account

To learn how to 
track cash in an 
investment 
account
From the Help menu, 
choose Index, and enter 
cash, managing in
investment accounts. 

Click EasyAction to enter a new transaction using the EasyAction forms. 

Click Edit to change an existing transaction.
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Quicken displays forms that you fill in for each transaction. 
When you’re done, Quicken records the transaction in the invest-
ment register. To see an example of an investment form, see “Use 
transaction forms for investments” on page 16.

After you become familiar with how Quicken enters investment 
transactions in the register, you can type them in yourself, or con-
tinue using the forms.

Downloading your investment transactions

The easiest way to track your investment transactions is simply 
to download them from your broker. Many brokerage firms and 
mutual fund companies offer online investment tracking services 
through Quicken. Apply for online service with your brokerage 
just as you would for a bank or other financial institution. 

For more information, see “Is online investment tracking avail-
able?” on page 18.

To learn more 
about entering 
investment 
transactions
For details about entering 
transactions in your invest-
ment register, from the Help 
menu, choose Index, and 
enter investments, 
entering transactions.

Quicken EasyActions 
forms step you through the 
action you are taking: 
buying, selling, 
reinvesting, transferring 
cash in or out of the 
account, and so on.

To get started 
with online 
investment 
tracking
From the Investing menu, 
choose Online Investing, 
and then choose the account 
you want to set up. To see if 
your brokerage firm offers 
this service, from the 
Finance menu, choose 
Online Financial Institution 
List. You can usually apply 
right away, either over the 
Internet or by phone. Your 
financial institution will 
send you a PIN and specific 
information for you to 
enable your Quicken 
accounts to use the service.

To learn about... Search the Help Index 
for...

handling common investment 
transactions

investments, entering transactions

rounding off rules round-off rules for investments

adjusting the cash or share 
balance of an investment 
account

investment accounts, balancing

entering the prior transaction 
history of a security

investment accounts, historical 
detail

tracking securities you don’t 
own

Watch List
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How can I monitor my progress?
After you have set up your investments in Quicken, you can view 
them in several ways: the Investment register, Investing Center, 
Security Detail View, Portfolio View.

Investment Register

The Investment Register shows individual transactions, plus bal-
ance updates, for a single investment account. 

Investing Center

The Investing Center in Quicken gives you at-a-glance analysis 
and summaries of the investments you own. You can view the 
value of your investments, check your asset allocation, or see 
your Watch List. If you have Internet access, you can also link to 
the Web for powerful research tools or security news and prices.

To update prices 
and news online
In either Portfolio View or 
Security Detail View, click 
Update, and then choose 
Get Online Quotes & News. 
You must have Internet 
access to use this feature.

To learn about... Search the Help Index for...
entering current prices in 
Portfolio View

prices, updating manually

entering the price history for a 
security

prices, history

updating prices online prices, updating online

To go to the 
Quicken 
Investing Center
From the Investing menu, 
choose Investing Center. 

The Investing 
Center helps 
you analyze 
your investing 
situation. If 
you have 
Internet 
access, it also 
provides the 
latest 
information 
from 
Quicken.com.
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Security Detail View: Price history and market 
value check-up

The Security Detail View window shows a price history graph 
based on the prices you have entered or downloaded for a single 
security. If you have Internet access, you can click the News tab to 
read headlines for the latest new stories about that security. 

Click here to display another 
security.

Click here to choose either a 
price history graph or market 
value graph.

This lists all the transactions 
you’ve recorded for the 
security. Double-click a 
transaction to edit it.
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Portfolio check-up: How much are your invest-
ments worth today?

The Portfolio View shows price and performance data for all the 
investments you track in Quicken, organized by account. (You 
can also group them by security, security type, investment goal, 
asset class, or Watch List.)

Market value is the number of shares you own of a stock times 
the price per share in today’s market. Employee stock options are 
different, because you purchase at a  discount. The market value 
of your options is equal to the number of options you have vested 
times the dollar value of your discount (market price minus your 
exercise price). If your exercise price is not lower than the market 
price, then your market value is calculated to be zero. 

Portfolio View shows all securities in all investment accounts. 
You can also view your securities by type, goal, asset class, or 
security name. You’ll find these choices on the “Group by” drop-
down list. 

To track multiple 
currencies 
From the Edit menu, choose 
Options, and then Quicken 
Program. Click the Settings 
tab, and then select the Mul-
ticurrency support
checkbox. 

For more information, from 
the Help menu, choose 
Index, and enter currencies.

Group by list

If you’d like to rearrange 
the columns or add new 
columns, such as ROI, 
Average Cost, 
or $ Invested, click 
Customize.

The market value of an 
account includes any 
cash that’s in the account 
(unless you set up your 
investment account to 
have an accompanying 
linked checking account).
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Creating a portfolio value report

The portfolio value report provides the same totals as Portfolio 
View, except you can subtotal by security type, goal, or asset 
class. For example, you can create a portfolio value report subto-
taled by investment goal.

If your investments don’t appear on a Net Worth report, click 
Customize, and then click Accounts. Make sure your investment 
accounts are selected. Click Create to re-create the report.

Performance check-up: Tracking the return on your 
investments

Quicken offers two measurements on investment performance: 
return on investment (ROI) and internal rate of return (IRR). 

Example. Say you made these transactions on ABC stock:

Return on investment (ROI) ROI shows the total profit you 
could make from a security if you sold your shares today. It is 
equal to dollars returned divided by dollars invested.

$ return is the total profit you’ve made from a security since you 
started investing in it. This includes the current market value 
plus cash received from sales of shares, minus $ invested.

$ invested is the amount you have invested in a security, exclud-
ing reinvested income.

To create a 
Portfolio value 
report (subtotaled 
by goal)
From the Reports menu, 
choose Reports and Graphs 
Center. Choose “How are 
my investments doing?” 
and then select Portfolio 
Value Report. Click Cus-
tomize. For Subtotal By, 
choose Investment Goal. 
Then click Create.

On this 
date

You created this transaction
At this 
price per 
share

12/31/98 Bought 100 shares $10

7/31/99 Bought 50 shares $15

12/31/00 Received a dividend of $40, which 
you reinvested in two more shares

$20
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Your $ invested in stock ABC from 12/31/98 to 1/4/00 is

Your $ return in stock ABC from 12/31/98 to 1/4/00 is:

Your ROI in stock ABC from 12/31/98 to 1/4/00 is:

T I P The performance numbers listed on your brokerage state-
ment may not match what you see in Quicken. There may be a 
slight difference due to the rounding of fractions. More typically 
it is a timing issue; the information your broker sends may not be 
as up-to-date as what you see in your current Quicken data.

Internal rate of return (IRR) IRR is a percentage equal to the 
interest rate on a bank account that would give you the same 
total return on your investment. IRR is also called average annual 
total return.

Here’s how it works over time:

■ If a mutual fund lists its one-year average annual total return 
as 20 percent, then $100 invested at the beginning of the year 
would have grown to $120 by the end of the year.

■ If a mutual fund lists its three-year average annual total 
return as 20 percent, and you invested $100 in that fund three 

 $ invested = (100x 10) + (50 x 15)

= $1,750

$ return = current market value - $ invested

= $3,040 – $1,750

= $1,290

ROI = $ return / $ invested

= $1,290/ $1,750

= 73.71%

To see complete 
descriptions of 
ROI and IRR
From the Help menu, 
choose Index, and
enter ROI.
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years ago, you’d have $172.80 (an increase of $72.80 or 
72.8 percent) today:

What happens when I sell?

Tracking capital gains and taxable investment 
income
Quicken provides tax reports that let you track your capital gains 
and taxable investment income. You can use the reports to manu-
ally complete your tax forms, or you can export your data to tax 
software programs, such as TurboTax.

A capital gains report lists long-term and short-term capital gains 
transactions for use in a Schedule D.

Ending
balance

1st year $120.00

2nd year $144.00

3rd year $172.80

To learn about... Search the Help Index for...
other investment reports investment reports

investment graphs investments, graphs

investment terms (for example, 
ROI, IRR, capital gains)

investments, terminology

other performance measures Portfolio View, columns in

To estimate 
capital gains
Check out the tax implica-
tions before you sell. From 
the Investing menu, choose 
Capital Gains Estimator. For 
more information see 
“Reduce your capital gains 
tax” on page 63.
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Seven reasons to go online
If you have Internet access, Quicken can update your portfolio 
throughout the day or week, and deliver the latest research and 
news directly to your Quicken desktop. 

Download transactions from your broker Sign up for online 
access with a participating broker to download investment hold-
ings and transactions directly into Quicken. For more on online 
investment tracking with Quicken, see “Is online investment 
tracking available?” on page 18.

Monitor your portfolio away from home Portfolio Export 
lets you place a copy of your Quicken securities portfolio on the 
Web. You can track your portfolio at home or away, from any PC 
with Web access. From the Finance menu, choose One Step 
Update. Click Customize to select a portfolio to export, and when 
you are done click Update Now. If you do not already have a 
Quicken.com user name, when you are prompted, click “Go 
online to Quicken.com” to create a new one. Save your 
Quicken.com user name and password—you’ll need them to 
export your portfolio and to view it from the Web.

Update security prices and security news The quickest way 
to update your security prices is to retrieve them from the Inter-
net. Just enter the ticker symbols for all your securities and let 
Quicken do the rest. Click One Step update and select Online 
Quotes and Security News. 

Download historical prices Knowing today’s security price 
doesn’t tell you much until you know how it compares to past 
performance. To see how your securities perform over time, from 
the Security Detail View, click Update, and then select Get
Historical Prices. 

Investment research and analysis Use the powerful 
Quicken.com investment research and analysis tools to learn 
about stocks and mutual funds before you buy. From the Finance 
menu, choose Quicken on the Web, and then Investment 
Research. Go to Quicken.com for market analysis, company pro-
files, and expert advice. 

To create a 
capital gains 
report
From the Reports menu, 
choose Reports and Graphs 
Center. Choose “How are 
my investments doing?” 
and then select Capital 
Gains Report. Select a time 
period and then click
Create Now.

To download 
historical prices
In the Portfolio View or 
Security Detail View, click 
Update, and then select Get 
Historical Prices. You must 
have Internet access to use 
this feature.
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Download asset classes Keep your portfolio on target by 
making sure your asset class information is correct. Enter ticker 
symbols for your securities,. Then from the Security Detail View, 
click Update, and then select Get Asset Classes. 

Investment Alerts If you update securities prices using One 
Step Update, Quicken can alert you when key events occur, 
including news events, maturity dates, or when a stock in your 
Security List reaches a high or low price that you specify. Enter 
ticker symbols for your securities, and from the Finance menu, 
choose Alerts. Click the Investments tab and then the alerts and 
conditions you want. 

Where do I go from here?
At some point in your financial life you may want to consult a 
professional financial planner. Quicken makes it easy to find a 
planner and gather the financial information you’ll need for your 
first appointment. Just use the Professional Planning Resources. 
In the Planning Center, click “How can I find a professional plan-
ner?”

■ Discover what professional planners do and what services 
are right for your situation

■ Learn what questions to ask and conduct an online search to 
find a planner in your area

■ Prepare for your first appointment

Quicken creates a Professional Planner Summary, developed by 
Quicken and the Institute of Certified Financial Planners, that 
gathers all your financial information in one report. Just follow 
the simple question-and-answer format. Quicken fills in much of 
the planner form for you, using your own Quicken data. When 
you are done, just print and mail the report to your planner.

To simplify your 
online sessions
From the Finance menu, 
choose One Step Update to 
download online banking 
and investments data in 
one session. 
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I N T U I T  S E R V I C E  A N D  S U P P O R T
How do I 
contact 
Intuit?
Do you need to know how to do something in 

Quicken? Are you running low on Quicken 

checks? Would you like to know how to apply 

for online financial services?

Intuit supports convenient fax, phone, and Web-based services that 

deliver the information and products you need—quickly. Visit our 

Technical Support website for answers to your questions or shop the 

Web for software, supplies, and Quicken checks. Use the Web or our 

toll-free numbers to sign up for two of Quicken’s biggest timesavers: 

online financial services and the Quicken Credit Card. To find out 

which service or support option is right for you, take a look at the 

listing on the following page. 
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Customer support
■ To find out about Customer Support 

options or to give us feedback on 
Quicken, visit our Web site:
http://www.intuit.com/support/quicken

Quicken Help
■ The Quicken Help system is the fast-

est, easiest way to get answers. 
Choose Index from the Help menu.

Web Help 
■ Web Help provides Knowledge Base 

searches, updates, and answers to 
frequently asked questions.
http://www.intuit.com/support/quicken

Fax on Demand 
■ Request a catalog of fax documents with 

answers to common questions. 
Fax on Demand 800-644-3198

Automated Technical Support
■ Answers to common questions. 

Automated Tech Support 800-644-3193

Customer Support Options
■ Purchase discounted Support Plans.

http://www.intuit.com/support/quicken
■ Talk to a Technical Support 

representative.
Phone 520-618-7130 
Phone 900-555-4392 
Monday - Friday, 5 am - 5 pm Pacific time 
Quicken telephone support is flexibly priced; 
terms and conditions are subject to change 
without notice.

Online financial services support
■ If the problem is caused by your Internet 

Service Provider (ISP) connection, call 
them directly. If not, click the Contact 
Info button in the Online Center. For 
setup problems, confirm your account 
information, then call Quicken Cus-
tomer Support.

Customer Service for CheckFree 
Payment Services
■ If a problem occurs after you transmit 

your transactions, call CheckFree. For all 
other problems, call Quicken for Win-
dows Technical Support.
CheckFree Customer 
Service 800-297-3180
Monday - Friday, 8 am- midnight Eastern time 

CreditCheck Service by
ConsumerInfo.Com
■ For help with your credit report, call: 

ConsumerInfo.Com
Customer Service 888-888-8553
Monday - Friday, 6 am - 6 pm Pacific time

http://www.consumerinfo.com/

Placing orders

Shop the Web
■ Purchase Intuit software and services at:

http://www.intuit.com/quicken_store/
Purchase Quicken checks, envelopes, 
and other supplies at: 
http://www.intuitmarket.com/

Quicken Checks Customer Service
■ Save time and get the most out of 

your software with Quicken checks. 
Please refer to the enclosed catalog 
for more information about ordering 
checks and other financial supplies. 
For additional information or to 
place your order:
Call from the U.S. 800-433-8810
Monday - Friday, 5 am - 8 pm Pacific time 
Saturday, 7:30 am - 1 pm Pacific time

Call from Canada 877-445-3233
Monday - Friday, 8 am - 5 pm Mountain time 

Intuit Direct Sales
■ To place a product order or to find prod-

uct information, see the following:
http://www.intuit.com/service/
TDD 800-843-8828
Monday - Friday, 8 am - 5 pm Pacific time

Call from Canada 888-829-1722
Monday - Friday, 8 am - 5 pm Mountain time
Extended hours September through April:
Monday - Friday, 6 am - 11 pm Mountain time
Saturday and Sunday 8 am - 8 pm

Overseas Sales:
Phone 520-901-3220
Fax 520-901-3208

Intuit Customer Service
■ The Intuit Customer Service department 

provides after-sale, non-technical ser-
vices such as tracing undelivered orders, 
providing replacement disks, and 
answering billing questions. 
http://www.intuit.com/service/
TDD 800-843-8828
Monday - Friday, 8 am - 5 pm Pacific time

Call from Canada 780-440-5952
Monday - Friday, 8 am - 5 pm Mountain time

Overseas Service:
Phone 520-901-3220
Monday - Friday, 7 am - 7 pm Pacific time 

Fax 520-901-3208

Getting started with online 
financial services 

Apply for online financial services
■ You need an Internet Service Pro-

vider (ISP) to use these services. 
To apply for online banking service 
(online account access and online 
payment), from the Banking menu 
choose Online Banking Setup and 
follow the onscreen directions.
For online investment tracking ser-
vice, from the Investing menu choose 
Online Investing Setup and follow 
the onscreen directions. 
For information on online financial 
services, and to see a list of partici-
pating financial institutions, see:
Web site http://www.intuit.com/online

Apply for online payment with Intuit
■ If your financial institution doesn’t 

offer online payment, you can apply 
for online payment through the 
Intuit Online Payment service using 
your existing checking account at a 
U.S. financial institution.
From the Banking menu, choose 
Online Banking Setup and follow the 
onscreen directions. In the Financial 
Institutions list, choose Intuit 
Online Payment.

Apply for a Quicken Credit Card
■ The Quicken Credit Card is offered 

through Intuit and Travelers Bank USA. 
You can download your transactions 
directly into Quicken. Current benefits 
include no annual fee, a credit line of up 
to $50,000, and an optional Traveler-
Miles travel awards program that 
earns free and discounted air travel. 
To apply, speak to a representative 
or visit our Web site:
Phone 800-442-4939, ext. 123
Web site http://www.quickencard.com/

Quicken Credit Card Support
■ If you are a current cardholder and have 

questions about your Quicken Credit 
Card account balance, available credit, 
or charge activity, please call Travelers 
Bank USA. 
Phone 800-772-7889

■ If you experience difficulty download-
ing your Quicken Credit Card transac-
tions into Quicken, call this number or 
visit our Web site:
Web site http://www.intuit.com/quick-
encreditcard/
Customer Support 520-618-7130
Monday - Friday, 5 am - 5 pm Pacific time 

H o u r s

Unless otherwise noted, all busi-
ness hours are seven days a week, 
24 hours a day, except to allow for 
system and server maintenance. 
Hours and phone numbers are 
subject to change.



I N D E X
H E L P

1 Choose Index from the 
Help menu.

2 Type a keyword and 
press Enter.

Numerics
401(k)

definition of plan 68
tracking in Quicken 55

403(b), definition of plan 68

A
accounts

asset 25
cash 33
creating 22, 74
credit card 17, 30
online payment with 16

adjustable rate mortgages 42
Alerts

setting up for credit card 31
using 11

asset accounts 25
asset allocation ??–72
asset classes, downloading 72
assets and liabilities 25
average annual total return 81

B
Billminder, using 12
bills. See paying bills 10
budgets 35
buying a home

down payment 39
mortgage types 41

private mortgage insurance 39
qualifying for a home loan 39

buying shares 75

C
capital gains

estimating 63
recording 75

Capital Gains Estimator 63
car loans, tracking in liability 

accounts 25
cash account 33
cash, tracking 33
categories

displaying the Category list 61
setting up for taxes 54, 60
tracking home sale 47
tracking with progress bars 35
using Tax Link Assistant to 

assign tax categories 61
Category & Transfer list 61
certificates of deposit 25
CheckFree 86
checks, ordering from Intuit 86
credit cards

benefits of using Quicken 
account to track 30

online account access for 17
setting an Alert 31
tips for selecting 32
tracking what you owe 30

credit report
reasons for reviewing 40
requesting 40

CreditCheck 86

D
data entry

in the register 10
with QuickEntry 12
with WebEntry 20

Debt Reduction planner 32
debts

and net worth 24
credit cards 25, 30
cutting expenses 34
reducing 32
tracking in liability accounts 25

deductions
charitable contributions 59
property tax 57
using Tax Deduction Finder 62

dividends 75
donations 59
down payments 39
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E
Emergency Records Organizer

about 51
emergency reserve

setting up 27, 66
emergency reserves 27–??
entering transactions

in the register 10
with QuickEntry 12
with WebEntry 20

expenses, cutting 34

F
Federal National Mortgage 

Association (Fannie Mae) 39
Financial Activity Centers

Investing Center 77
Tax Center 59

Financial Address Book, using 52
Financial Calculators

Loan 40
Refinance 46
Retirement 70

Financial Calendar 11, 36
finding

mutual funds 73
tax deductions 62

fixed annuities, tracking 25
flexible spending plans 55
foreign income taxes 58

G
graphs

asset allocation 72
investment 78

H
Help, using 3
home

creating an asset account 43
home improvements

and tax basis 59

I
Individual Retirement Accounts 

(IRAs)
contribution limits 68
definition 68
tax-savings example 54

insurance
checking coverage 28
getting information online 28
inflation guard endorsement 50
private mortgage insurance 39
reports on coverage 28, 51

InsureMarket 28
intermediate-term fixed-rate 

mortgages 42
internal rate of return (IRR) 81
Investing Center 77
investments

balancing risk and reward 71
certificates of deposit 25
entering interest earned 75
entering transactions 76

fixed annuities 25
online stock quotes and news 77
tax implications 57
tracking in asset accounts 25
Treasury bills 25
using Alerts 11
viewing in the register 77
viewing market value graphs 

78
viewing price history 78

IRS publications 59

K
Keoghs 70

L
lists

Category & Transfer 61
Financial Calendar transaction 

list 11, 36
Memorized Transaction 10

Loan Calculator 40
loans

adjustable rate 42
borrowing against your home 

46
estimating payments 40
evaluating 41
Fannie Mae guidelines 39
intermediate-term fixed rate 42
long-range fixed-term 41
qualifying 39
researching 41

long-range fixed-term 
mortgages 41
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H E L P

1 Choose Index from the 
Help menu.

2 Type a keyword and 
press Enter.

M
market conditions 77
market value 78–79
memorized reports 23
memorized transactions, using 10
mortgages

adjustable rate 42
intermediate-term fixed-rate 42
long-range fixed-term 41
researching 41
tracking in liability accounts 25

mutual funds
researching and screening 73

My Finances Center 12

N
net worth

calculating 24
customizing report 24
definition 25
report 24

O
One Step Update 84
online banking

applying for 86
technical support 86

online features
data entry from the Web 20
download asset classes 72
getting stock quotes and news 

77
historical securities prices 83
InsureMarket 28

market conditions 77
One Step Update 84
portfolio export 83
QuickenMortgage 41, 46
researching securities 73
security news headlines 78

online investment tracking
applying for 86
portfolio export 83

online payment
about 16
technical support 86

onscreen Help 3
onscreen user’s guide 3
organizing

financial and legal records 51
owning a home

property tax deduction 57
refinancing 46
tracking proceeds of home 

sale 48
tracking sales expenses 47

P
paychecks 60
paying bills

Billminder 12
memorized transactions 10
online payment 16

scheduling 10
setting up reminders 11
using Alerts 11

personal property taxes 58
phone numbers 86
PIN Vault 17
planning

insurance 28
investments 71
loans 40
reducing debt 32
refinance 46
retirement 70
setting up a savings goal 39
taxes 63

Planning Center 26
points

definition 41
handling when you refinance 

46
Portfolio Export 83
portfolio value report 80
Portfolio View 79
private mortgage insurance 39
product support 86
products, ordering from Intuit 86
progress bars 35
property taxes 57

Q
Quicken Credit Card 17, 31, 86
Quicken Home Inventory

insurance coverage report 51
using to track the value of your 

possessions 50
Quicken Reminders window 11
QuickEntry 12
quotes, getting online 77
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R
real estate taxes 58
reducing

debt 32
expenses 34
taxes 54

Refinance Calculator 46
refinancing

tracking costs 46
your home 46

reminders, using 11
reports

cash flow 22
insurance coverage 28, 51
memorized 23
net worth 24
portfolio value 80
tax schedule 62
tax summary 63

researching
stocks and mutual funds 73

retirement accounts
and taxes 54

Retirement Calculator 70
retirement plans

401(k) 68
403(b) 68
Individual Retirement 

Accounts 68
Keoghs 69
Simplified Employee Pension 

Plans (SEP-IRAs) 69

S
savings goals

account name used 39
creating 39

scheduled transactions 10
securities

asset allocation 72
downloading prices 77
historical prices 83
news about 77
researching and screening 73
risk 72

Security Detail View 78
selling a home

tracking expenses 47
tracking proceeds 48

shares
buying and selling 75

Simplified Employee Pension 
Plan, Individual Retirement 
Plan (SEP-IRA) 70

software, ordering from Intuit 86
state and local income taxes 58
stock quotes, getting online 77
supplies, ordering from Intuit 86

T
Tax Center 59
Tax Deduction Finder 62
Tax Link Assistant 54, 61
Tax Planner 63
tax preparation software 64
tax schedule report 62
tax summary report 63
taxes

and retirement accounts 54
charitable contributions 59
creating tax reports 54, 62
deductible taxes 58
donations of goods and 

clothing 59

fair market value of 
donations 59

finding your tax bracket 57
flexible spending plans 55
impact on investments 57
IRS forms 59
property tax deduction 57
reports on 62
Schedule A 58
setting up tax-related 

categories 54, 60
strategies for reducing 54
tax preparation software 64
tracking refinancing costs 46
using Tax Deduction Finder 62
using Tax Link Assistant 54, 61
using Tax Planner 63

technical support 86
tracking

401(k) 55
cash 33
certificates of deposit 25
credit card debt 30
financial and personal 

addresses 52
fixed annuities 25
flexible spending plans 55
paycheck deductions 60
Treasury bills 25

transactions
entering a paycheck 60
investment 75, 76
tracking proceeds of home

sale 48
transfers

in investment accounts 75
scheduled transactions 36

Treasury bills, tracking 25
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H E L P

1 Choose Index from the 
Help menu.

2 Type a keyword and 
press Enter.

U
upgrades, ordering from Intuit 86

V
viewing

investment information 77
news about securities 78
your loan in Quicken 43

W
Web

data entry 20
see also online features
viewing securities portfolio 83

WebEntry 20

Y
Year 2000 Compliant Standard ii
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